NAE Update Tool Help
## Contents

NAE Update Tool introduction ...................................................................................................................... 5

Summary of changes ....................................................................................................................................... 5

**NAE Update Tool overview** ......................................................................................................................... 6

Quick start reference ....................................................................................................................................... 6

Three methods for updating network engines............................................................................................... 8

Terms............................................................................................................................................................... 8

Overview of the NAE update process .............................................................................................................. 9

Upgrade overview .......................................................................................................................................... 9

Migrating from NCM45-2 to NAE45-2 .............................................................................................................. 10

Migrating from NAE45-2 to NCM45-2 .............................................................................................................. 11

NCE25 update considerations ......................................................................................................................... 11

NIEx9 update considerations ......................................................................................................................... 11

**NAE Update tool requirements** ..................................................................................................................... 11

  - System requirements .................................................................................................................................. 11
  - MTU setting of 1500................................................................................................................................... 12
  - Determining the MAC address...................................................................................................................... 12

**User interface overview** ............................................................................................................................. 12

  - Main screen.............................................................................................................................................. 12
  - Characteristics of the NAE Update Tool .................................................................................................... 15

Update processes.............................................................................................................................................. 17

Quick and extended update types...................................................................................................................... 18

Set Defaults menu selection............................................................................................................................. 19

Set Communication Options menu selection................................................................................................... 24

Diagnostic Log window.................................................................................................................................... 28

**Auto-Saving NAE log files** ........................................................................................................................... 29
NAE Update Tool introduction

This document provides the following information:

• instructions for updating software engine images of Network Automation Engines (NAEs), Network Integration Engines (NIEs), and Network Control Engines (NCEs) to any supported Metasys system software release. For additional system upgrade details, see Related documentation.

• prerequisites of the NAE Update Tool.

• migration process from an NAE45-2 to an NCM-45-2.

Note: In this document, unless otherwise noted, NAE refers to all NAE35, NAE45, and NAE55 models; all NIE29, NIE39, NIE49, NIE55, and NIE59 models; all NCE25 models; and all NCM 45x0-2s migrating to NAE45s. This document does not apply to the NAE85/NIE85/NIE89 engines.

Summary of changes

The following is new or revised for the NAE Update Tool at Release 10.1:

• Updated the document to show that PxE Only is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later.

• Updated the document to show that the NAE Update Tool cannot be used to update SNE and SNC engines.

• Updated Migrating from NCM45-2 to NAE45-2 to indicate that migration from an NCM45-2 to an NAE45-2 is not supported at Release 10.0 and later.

• Added information about the new encryption of network engine images to Extracting the engine images to your computer.

• Updated the Adding NAE Update Targets topic to indicate that there is no UI resources file available to download to an NAE35, NAE45, NCE25, or NIE29/39/49 at Release 9.0.7. To obtain a UI resources file, you can either (a) view the device from its site director, (b) view another device at the same release to load the UI resource, or (c) manually load the UI resource.

• Updated the Quick and Extended Update Types topic to indicate that the Quick Update process is not supported for loading an NAE35, NAE45, NCE25, or NIE29/39/49 Release 9.0.7 image.

• Documented that IPv6 is unsupported at this release. It is recommended that you disable IPv6 on your machine when using the NAE Update Tool. For detailed instructions see Troubleshooting.

• Updated NIEx9 update considerations topic to indicate that if you are upgrading an NIEx9 to Release 9.0.7 or later, you are not required to backup the protocol Dynamic Link Library (DLL) or license files with the NIEx9 Driver Manager Tool.
NAE Update Tool overview

The NAE Update Tool is bundled with the System Configuration Tool (SCT) at Release 13.1. When you install SCT 13.1 software, the installer also installs the NAE Update Tool Release 13.1 in the background. After SCT installation, a separate menu item is available for SCT and the NAE Update Tool in Start > All Programs > Johnson Controls.

Note: When you uninstall SCT 13.1, the bundled NAE Update Tool 13.1 is also uninstalled for you. Because the tool is bundled with SCT, you cannot separately uninstall the NAE Update Tool 13.1 without also uninstalling SCT 13.1. The NAE Update Tool has no separate entry in the list of installed Windows® programs.

The NAE Update Tool updates the disk image of one or more NAEs remotely, over the facility’s local area network, or locally, using an Ethernet switch or router.

Notes:

• To use the NAE Update Tool effectively, you should have some basic knowledge of computer networking. For general information, refer to the Network and IT Guidance for the BAS Professional Technical Bulletin (LIT-12011279). In addition, review the Network and IT Guidance for the IT Professional Technical Bulletin (LIT-1201578) with the customer’s IT department to confirm the network is configured properly to use this tool.

• If a Preboot Execution Environment (PXE) server exists on a network with NAEs, you may not be able to update the NAEs while they are connected to the network. In this case, see Stand-Alone NAE update for further instructions. NxEX5xx-2 engines, NxEX5xx-3 engines, and NxEX25/35/45 engines at Release 6.0 or later are not affected by PXE servers on the same network.

Quick start reference

About this task:

Note: Use this section as a quick reference if you are experienced with updating NAEs.

This section assumes that the NAE Update Tool is installed on the computer and that you have extracted all the proper files needed to update the engine.

1. Verify that the NAE and the image files that you want to update are online, connected to the building network, and accessible from your desktop or laptop computer. Use the ping command at the command prompt to verify that the NAE is reachable.

2. Route all collected trend samples from each NAE to the repository of the ADS/ADX. For details, refer to the Metasys SCT Help (LIT-12011964).

3. Using SCT, upload and back up the database of each NAE you want to update.

Important: If you are updating an NIEx9 prior to Release 9.0.7, you need to back up the DLL and license files with the NIEx9 Driver Manager tool. If you skip this step, you are not able to restore the DLL and license files to the NIEx9 after you update the engine. The Modbus, M-Bus, and KNX also do not work without these files prior to this release.

Note: It is recommended that you backup the files as a precaution if you need to revert back to a release prior to 9.0.7 after upgrading to Release 9.0.7.
4. Verify proper setup of the desktop or laptop computer on which you installed the NAE Update Tool. Set the computer to the MTU of 1500. Switch off all firewalls and make sure that the following ports are open: 67, 68, 69, 80, 162, 9910, and 9911.

5. Start the NAE Update Tool. If your computer has multiple Ethernet adapters, a selection screen appears (Figure 1).

**Figure 1: NAE Update Tool – Ethernet Adapter Selection**

![Image of Ethernet Adapter Selection Screen]

6. Select a wired Ethernet adapter that has a non-zero IP address and click **OK**.

**Note:** If all Ethernet adapters listed have zero addresses (0.0.0.0), click **OK**, exit the NAE Update Tool, and enable at least one Ethernet connection. Then restart the tool. The main screen of the NAE Update Tool appears (Figure 2). An IP address of 0.0.0.0 is listed in the display if the patch cable is not connected. Check and verify that the patch cable is properly connected, and then restart the NAE Update Tool.

**Figure 2: NAE Update Tool – Main Screen**

![Image of Main Screen]

7. If you retained the target file from an earlier version of the NAE Update Tool that contains your NAE targets, load it now with **File > Load Target File**. When you upgrade the NAE Update Tool from an earlier version, the old file is saved for you.

**Note:** If you did not retain a target file, you can populate the Target List of engines from an SCT archive. You can also manually add NxE devices by adding the NAES that you want to update and use the **Test Login Before Update** function to help you fill in the required configuration settings from each NAE.

8. Verify that you can communicate with each NAE you want to update.

9. Select the disk image for each device and select **Enable** in the **Status** field. (Engine images can be obtained from the Johnson Controls License Portal). You can select multiple disk images using the **Shift** + click or **Ctrl** + click key combinations, and then either select **Edit** from the NAE/NCE menu or right-click and select **Edit**.
10. Verify that your Ethernet connection is currently active and shows a status of connected.

11. Verify that no one is currently logged in to the Site Management Portal (SMP) UI of the NAE. If so, make sure that they log out before you proceed.

12. Select the NAE from the Target List and click **Start Update**. If any error occurs or if the process does not complete, see **Troubleshooting**.

13. Wait for a **Completed** status for the device; how long this reset takes depends on the engine. See **NAE update stages and timelines**.

14. Use the SCT to download the NAE database. The release levels of the SCT and the NAE database must match; if they do not, use the SCT Archive Upgrade Tool (Release 5.2 or earlier) or the SCT (Release 6.1 or later) to upgrade the NAE database before you download it.

15. Browse to the device to verify that it is online after the NAE has been downloaded.

**Note:** If a Site Director for the NAE was not specified, specify the time zone, date, and time of day for your location.

### Three methods for updating network engines

You have three update process selections with the NAE Update Tool. Which process you select depends on the release of the **Metasys** image and the building network. The three methods are:

- **PXE Only:** Use this method to update devices within the same subnet.
  
  **Note:** **PXE Only** is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later. However, if the **PXE Only** method does not work, see **Stand-Alone NAE update** for an alternate method.

- **HTTP Only:** Use this method to update devices across multiple subnets.

- **PXE or HTTP:** Use this method to allow the tool to decide which method is best.

**Note:** The NAE Update Tool cannot be used to update SNE and SNC engines.

### Terms

- **DHCP**
  Dynamic Host Configuration Protocol. A set of communication rules that allows a Network Administrator to assign IP addresses when NAEs and other devices are plugged into a network. It enables dynamic IP network configuration and IP addressing.

- **HTTP**
  Hypertext Transfer Protocol. One of two possible technologies that the NAE Update Tool uses to update an NAE disk image. The HTTP method is used to update NAEs across different subnets.

- **NAE Disk Image**
  An NAE disk image is a collection of all the software files needed for the operation of the NAE.
The NAE Update Tool

The NAE Update Tool is a software utility used to reload the disk image into an NAE.

**PXE**

Preboot Execution Environment. The technology that the NAE Update Tool uses to update an NAE disk image within a subnet. The PXE method updates any release of the NAE and is faster but less convenient than the HTTP method.

**TFTP**

Trivial File Transfer Protocol. A technology used to transfer files between computers.

**Linux Operating System**

An operating system based on UNIX. Linux is widely used as a server operating system, especially on Web servers.

Overview of the NAE update process

Table 1 outlines the NAE update process that the NAE Update Tool uses.

**Table 1: Steps in NAE Update Process**

<table>
<thead>
<tr>
<th>Step</th>
<th>Name of Process</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Queued</td>
<td>Placing the device in the queue of NAEs that require an update.</td>
</tr>
<tr>
<td>2</td>
<td>Establishing Connection</td>
<td>Establishing a network connection to the NAE.</td>
</tr>
<tr>
<td>3</td>
<td>Erasing Flash</td>
<td>Clearing flash memory to provide room for the new code.</td>
</tr>
<tr>
<td>4</td>
<td>Installing Operating System</td>
<td>Installing the latest operating system.</td>
</tr>
<tr>
<td>5</td>
<td>Transferring Files</td>
<td>Transferring necessary files to the NAE.</td>
</tr>
<tr>
<td>6</td>
<td>Extracting User Interface Resource Files</td>
<td>Extracting the resource files for the user interface. <strong>Note:</strong> There is no UI resources file available to download to NxE-25,35 and 45 devices at Release 9.0.7. To obtain a file you must either (a) view the device from its site director, (b) view another device at the same release to load the UI resource, or (c) manually load the UI resource.</td>
</tr>
<tr>
<td>7</td>
<td>Metasys Installing</td>
<td>Completing all file transfers and waiting for the NAE to start the updated Metasys software for the first time.</td>
</tr>
<tr>
<td>8</td>
<td>Writing Attributes and Reset</td>
<td>Writing the NAE Host Name, Site Director name, and IP Address settings (if applicable) to the device, then resetting the device.</td>
</tr>
<tr>
<td>9</td>
<td>Completed</td>
<td>Verified that the NAE is properly configured, online, and operational.</td>
</tr>
</tbody>
</table>

Upgrade overview

The NAE Update Tool is only part of the system upgrade.
Important: Before performing a system upgrade, refer to the *Metasys Server Installation and Upgrade Instructions (LIT-12012162)* for details on the rest of the upgrade process, including database management and upgrading the Site Director.

The following is an overview of the upgrade process:

1. Route all collected trend samples from each NAE to the repository of the ADS/ADX. For details, refer to *Metasys SCT Help (LIT-12011964)*.

2. Upload all databases to the SCT. If the NAEs are at different releases, upload using SCT at the same release as the NAE.

3. If the NAE is at Release 5.2 or earlier, use the SCT to back up the Security System database of the previous software release. If the NAE is at Release 6.1, skip this step because the security system database is now part of the archive.

4. Use the SCT to back up the databases that you uploaded in Step 1.

   Important: If you are updating an NIEx9 to a release prior to 9.0.7, also back up the protocol DLL and license files with the NIEx9 Driver Manager tool. If you skip this step, you are not able to restore the DLL and license files to the NIEx9 after you update the engine. The Modbus, M-Bus, and KNX also do not work without these files prior to this release.

   Note: It is recommended that you back up the files as a precaution if you need to revert back to a release prior to 9.0.7 after upgrading to Release 9.0.7.

5. If you have not done so already, upgrade the SCT software to the new release, which is the same release as the NAE Update Tool. If installed on the same computer, the Release of SCT must match the release of the NAE Update Tool.

6. Upgrade the archive database to the new release. Verify that the archive database converts successfully before you upgrade any NAEs.

7. Upgrade any Application and Data Servers/Extended Application and Data Servers (ADSS/ADXs) on the network.

8. Update the NAE disk image using the NAE Update Tool and this document.

9. Download the archive database using the SCT. No separate security system restore is required because starting at Release 6.0, the archive database download includes the security database.

Migrating from NCM45-2 to NAE45-2

You can migrate an NCM45-2 to an NAE45-2 using the NAE Update Tool. To migrate an NCM45-2 to an NAE45-2, use the correct NAE45-2 image and follow the same procedure as if you were updating an original NAE45-2.

Note: Migration from an NCM45-2 to an NAE45-2 is not supported at Metasys system Release 9.0.7.

**Table 2: NCM45-2 to NAE45-2 Conversion**

<table>
<thead>
<tr>
<th>NCM Model Number</th>
<th>NAE Model Number</th>
<th>Internal Model Number</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCM4510-2</td>
<td><strong>NAE4510-2</strong></td>
<td>NAE4510 (NCM4510)</td>
<td>N2 Network Communication</td>
</tr>
</tbody>
</table>
Table 2: NCM45-2 to NAE45-2 Conversion

<table>
<thead>
<tr>
<th>NCM Model Number</th>
<th>NAE Model Number</th>
<th>Internal Model Number</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCM4520-2</td>
<td>NAE4520-2</td>
<td>NAE4520 (NCM4520)</td>
<td>LonWorks® Compatible Network Communication</td>
</tr>
</tbody>
</table>

Migrating from NAE45-2 to NCM45-2

You can use the NAE Update Tool to restore the NCM45-2 code to the unit. Double-click NCM45Release_12.04N.exe to extract the files to the C:\NAEUpdateTool\tftpfiles folder. Start the NAE Update Tool and select the NCM45-Release_12.04N.rgz file as the image to be downloaded to the controller. Initiate the update to change the device to an NCM45-2.

⚠️ **Note:** If the NAE45-2 was not originally an NCM45-2, you cannot migrate it to an NCM45-2.

NCE25 update considerations

➤ **Important:** The update procedure for the supervisory engine on an NCE25 is the same as for an NAE35 or NAE45; however, the direct digital field controller on an NCE25 cannot be updated with the NAE Update Tool. Refer to the *NCE Technical Bulletin (LIT-12011267)* for information on updating and downloading the field controller portion of an NCE25.

NIEx9 update considerations

➤ **Important:** If you are updating an NIEx9 to a release prior to 9.0.7, you must back up the protocol DLL and license files with the NIEx9 Driver Manager tool. If you skip this step, you are not able to restore the DLL and license files to the NIEx9 after you update the engine. The Modbus, M-Bus, and KNX integrations also require these files prior to this release.

⚠️ **Note:** It is recommended that you backup the files as a precaution if you need to revert back to a release prior to 9.0.7 after upgrading to Release 9.0.7.

NAE Update tool requirements

System requirements

The NAE Update Tool is bundled with the SCT install. For system requirement information, refer to the *SCT Installation and Upgrade Instructions (LIT-12012067)*.

It is advisable that you ensure the below measures are in place for best performance:

- An external power adapter to an AC power source. We recommend that you do not run the NAE Update Tool computer on battery power during the update process. If a low battery message appears, you cannot see it because it appears behind the NAE Update Tool screen.

- An active connection to the facility’s network.

- Appropriate sleep settings for the hard drive. Configure your computer’s Power Plan settings to prevent the hard drive from going to sleep during the upgrade process.
MTU setting of 1500

If the MCI Access Manager Client software or Cisco® AnyConnect® VPN Client is installed on your computer, change the MTU setting to 1,500 bytes on the network connection you are using before you start using the NAE Update Tool. You can also verify that the MTU setting is correct by using the Test MTU procedure available under the Set Communication Options menu selection. See Test MTU tab. Also, verify that the Virtual Private Network (VPN) software on your computer does not have a firewall enabled. If a firewall is detected, a message appears when you start the NAE Update Tool.

To verify that the MCI Access Manager Client software is installed on your computer, browse to C:\Program Files and look for Cisco® VPN Client. To verify that the Cisco AnyConnect VPN Client software is installed on your computer, browse to C:\Program Files (x86)\Cisco\Cisco AnyConnect VPN Client. See Preparing the computer and NAE for instructions on setting the MTU.

Determining the MAC address

Determine the MAC address of the NAE you want to update. The MAC address is necessary for PXE updates, but optional for HTTP updates. You can determine the address by performing an NAE test login with the NAE Update Tool. Other methods are also available. See Determining the MAC address of an NAE.

User interface overview

Main screen

The following figure shows the main screen of the NAE Update Tool.

**Figure 3: Metasys NAE Update Tool Main Screen**

1. The description column lists each NAE that is scheduled for an update.
2. Click on **Start Update(s)** to initiate the update process for all selected NAEs.
   - **Note:** Initiating an update with the **Start Update** button does not work if the PXE update option is selected or if the NAE is currently at Release 4.0 or earlier.
3. You can sort all columns for easy grouping. For example, you can group and select all NAE45s to be updated together.

**Table 3: Components of the Main Screen**

<table>
<thead>
<tr>
<th>Callout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The description column lists each NAE that is scheduled for an update.</td>
</tr>
<tr>
<td>2</td>
<td>Click on <strong>Start Update(s)</strong> to initiate the update process for all selected NAEs.</td>
</tr>
<tr>
<td>3</td>
<td>You can sort all columns for easy grouping. For example, you can group and select all NAE45s to be updated together.</td>
</tr>
</tbody>
</table>
Table 3: Components of the Main Screen

<table>
<thead>
<tr>
<th>Callout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Select the <strong>Add UI Resources</strong> check-box to download the user interface resources file to the NAE. Selecting this option is equivalent to enabling UI Resources on the <strong>Edit update target</strong> screen. The <strong>Add UI Resources</strong> option applies to an Extended update for NAE35s, NAE45s, NIE29s, NIE39s, NIE49s, and NCE25s only. <strong>Note</strong>: There is no UI resources file available to download to NxE-25,35 and 45 devices at Release 9.0.7. To obtain a file you must either (a) view the device from its site director, (b) view another device at the same release to load the UI resource, or (c) manually load the UI resource.</td>
</tr>
<tr>
<td>5</td>
<td>Menu options provide various tool selections.</td>
</tr>
<tr>
<td>6</td>
<td>The <strong>Target List</strong> indicates the NAEs that are scheduled for updates.</td>
</tr>
<tr>
<td>7</td>
<td>The split screen adjuster resizes the device list and the <strong>Diagnostic Log window</strong>.</td>
</tr>
<tr>
<td>8</td>
<td>The <strong>Diagnostic Log window</strong> chronologically lists events that occur during each update.</td>
</tr>
<tr>
<td>9</td>
<td>Messages regarding the update process appear here. More detailed information appears when you enable <strong>Advanced Mode</strong>. The contents of this window are saved automatically when you exit the tool.</td>
</tr>
<tr>
<td>10</td>
<td>Click the <strong>Details</strong> cell to display a window that lists more details about the update. These details save automatically when you close the tool.</td>
</tr>
</tbody>
</table>

Descriptions of the columns in the main screen

The following table describes the columns that appear on the Main screen.

Table 4: Column Descriptions on Main Screen

<table>
<thead>
<tr>
<th>Name of Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>Model number of the device that you select when adding the target.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional text field that helps identify the device.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>MAC address for the device, usually indicated by a sticker on the device. This address is required for PXE updates but optional for HTTP updates. If not specified for a HTTP update, the tool reads and stores the MAC address from the device at the start of the update.</td>
</tr>
<tr>
<td>Status</td>
<td>State of the update: either <strong>Enabled</strong>, <strong>Disabled</strong>, or <strong>Completed</strong>. A fourth state, <strong>Missing File: &lt;missing filename&gt;</strong>, appears if the tool cannot find the image file currently selected for this device. To resolve this error, select a valid file. For each NAE, change the status to <strong>Enabled</strong> to prepare the NAE for an update. Change the status to <strong>Disabled</strong> if you do not want to update the NAE or you want to stop an update that is in progress. The field changes to <strong>Completed</strong> after the device has been updated.</td>
</tr>
<tr>
<td>Progress</td>
<td>Progress bar that contains text to describe the current step of the update while the process runs. Reads <code>&lt;inactive&gt;</code> when no update is in progress.</td>
</tr>
<tr>
<td>Disk Image</td>
<td>Name of the disk image file that has been selected for the device. The disk file can be for any supported Metasys system release, including older releases.</td>
</tr>
<tr>
<td>Name of Column</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Host Name</strong></td>
<td>Name that was assigned to the device. During the update, this name is added to the Computer Name attribute in the Engine object. A Host Name is required for HTTP updates but optional for PXE updates. If no Host Name is provided for an NAE or NIE59 (only), the NAE is named <strong>NAE</strong> plus its MAC address (for example, NAE00806650051F). If no Host Name is provided for the NIE29, NIE39, or NIE49, the NIE is named <strong>NIE</strong> plus its MAC address (for example, NIE00806650051D).</td>
</tr>
</tbody>
</table>
| **Details** | Information about a device update as it proceeds or the final update result. Possible values include:  
  • `<blank>`: device was not updated during this session of the tool.  
  • **Waiting**: update is planned but has not yet started.  
  • **Updating**: update is in progress.  
  • **Resetting**: device has received all necessary files and is resetting to load new files.  
  • **OK**: last update was successful and verified.  
  • **Error**: last update was unsuccessful; **Status** field remains **Enabled**. See Troubleshooting. |
| **Device Login** | Login user name that is used to communicate with the device (if defined; otherwise, blank). |
| **Fixed IP Address** | Shows the static IP address configured for the device. This field is blank if DHCP is enabled for the device. |
| **Site Director** | Name of the Site Director configured for the device (if defined). |
| **Update Process** | Which process is selected for updating the NAE. The selections are:  
  • **PXE Only** (update devices in this subnet only).  
  • **HTTP Only** (update devices in any subnet).  
  • **PXE or HTTP** (update devices in any subnet).  
  ⊗ **Note:**  
    • **PXE Only** is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later.  
    • The NAE Update Tool cannot be used to update SNE and SNC engines. |
Characteristics of the NAE Update Tool

- Updating a device requires that you specify a valid *Metasys* user name and password. In previous releases, the MetasysSysAgent user and the default password were used. Starting at Release 6.0, the default password for the MetasysSysAgent user has a different value, and a mandatory password change is enforced when you access a newly flashed device for the first time. If the login is not successful, the NAE Update Tool cannot update the NAE.

- The NAE Update Tool can update NAEs at different image releases. For example, you can update one NAE45 to Release 9.0 and another to Release 5.2.

- If you downgrade an NAE35, NAE45, or NCE25 to Release 5.2 or earlier, use the *Extended* update process.

- If you need to downgrade an NAE from Release 5.2, 5.1, or 5.0 to an earlier release, you must perform the downgrade over the same subnet or use the stand-alone method. See *Stand-Alone NAE update*.

- NAEs automatically register with the Domain Name System (DNS) after an update with the NAE Update tool. This action provides more reliable name resolution.

- You can select up to 50 devices to update at a time, but you can only update 20 devices simultaneously. NAEs from older releases can also be included in the 50-device count. The remaining devices are queued to start as soon as the other devices have completed.

- For NAEs currently at Release 4.1 or later, you can begin the update without restarting the device manually using the *Start Update* button. For NAEs at Release 4.0 or earlier, you must restart the device locally for the update to begin. For instructions, see *Upgrading an NAE* or migrating an NAE45-2 to an NCM45-2.

- When you click *Start Update* for an NAE35/45, NCE25, or NIE29/39/49, the NAE Update Tool determines if a *Quick* or *Extended* update of the device is required, and then proceeds with the appropriate update, even if you made an incorrect selection. Also, if you restarted the NAE manually to begin the update, the tool always selects the *Extended* update process.

- Before you start an NAE update, you can verify that the device is accessible by logging into the NAE from the NAE Update Tool using the Test Login procedure. See *Testing login before updating NAE*. This test also helps verify IP address information (if Enable DHCP is not selected) and facilitates the retrieval of the MAC Address (if the HTTP update method is selected). If the retrieved IP Address information is different from the current configuration, the tool provides the option of updating these values to match. In addition, the tool verifies that the device can accept a *Quick* update after you close the Login Result window. If you selected *Quick* update, but the device lacks the required flash memory, a message appears and an information message is added to the Details window for the device. The tool changes the update type to *Extended* in this case.

- Before you start to update a device, make sure all clients exit the device. (There is no method to determine who is currently logged in). If someone is logged into the device while it is updating, the new device information is not shown and the new version of Java® software is not offered for download after the update completes. Without the new version of Java software, new device features may not display correctly in the user interface.
• All of the columns on the main screen (Figure 3) can be sorted; for example, you can group all entries by device type, by disk image file name, and so forth. As a best practice, you may want to sort the Target List by device type when specifying image files and before starting to update multiple units. The sorting order is preserved when you exit the tool.

• You can edit a device entry using several methods: right-clicking its field and selecting Edit; highlighting it, and then selecting Edit from the NAE/NCE menu; or highlighting it, and then pressing Enter. You can also delete a device entry using the right-click menu or Delete menu option.

• You can edit multiple device entries on the Target List (Figure 3) at the same time using a mass-edit operation. Select two or more device entries using the Shift + Click or Ctrl + Click key combinations, and then either select Edit from the NAE/NCE menu or right-click and select Edit. When you select multiple entries for editing, you can mass-edit all modifiable non-unique information for all selected devices at once. Examples of these fields include Description and Status. A restriction for mass-editing the NAE password is that you must also specify the user name. Fields that are unique for each device, such as MAC Address and Host Name, are disabled from editing on the screen during a mass-edit operation. (You can also mass-delete device entries by selecting multiple devices in the Target List).

• If Advanced Mode is disabled, only DHCP discovery messages and the final state of each update is shown in the Log window. You can see more details for each update by enabling the Advanced Mode or by opening the Details window for the device. The Details window shows information about the last update performed on the device during the active session of the NAE Update Tool. If the Details window is displayed and in focus while an update is in progress, its content refreshes. At any time, you can copy text that appears in the Log and Details windows to the clipboard or save it to a text file. You can also save the contents of the Log window to a text file by selecting File > Save Diagnostic Log. If you do not manually save the contents of the Log or Details window, it automatically saves as a text file for future reference when you exit the tool.

• If your computer has multiple Ethernet adapters, the tool displays a Select Ethernet Adapter dialog box that allows you to select which one to use. This dialog box appears only when you start the NAE Update Tool. By default, the first wired and enabled adapter found on the computer is preselected. To change the adapter selection, restart the tool.

• The Load Target File and Save Target File menu selections allow you to load and save the NAE targets listed in the main window. The file is in text format with a default name of xpeclients.txt. Among other items, user names and encrypted passwords for each NAE are saved in the target file.

• The Load Target List From SCT Archive feature has been added as an option in the File menu. The user can access a specific archive to populate devices in the user interface, allowing devices that failed the SCT download to be enabled with a PXE download.

• You can specify the NAE Host Name, its static IP Address (if used), and the name of its Site Director when you add or edit the NAE target. These attributes are written to the device as part of the update, saving you this extra step later. In addition, at the completion of the update, the tool verifies that these values have been written correctly to the NAE and alerts you if discrepancies exist. The tool also checks the intended release level of the NAE.
Note: The NAE Update Tool places restrictions on the NAE Host Name values that you can use for NAE35, NAE45, NCE25, and NIEx9 models. Name values must start with a letter, end with either a letter or a number, and contain dashes only in the interior of the name. The Host Name must contain a letter other than or in addition to the letter A. For example, A522446 is not valid, but either A522446B or AB52446 is valid. Failure to follow the Host Name restrictions results in the Computer Name value changing when an NAE35, NAE45, NCE25, or NIE29/39/49 is updated.

If an entry on any definition screen contains a missing or incorrect value, a red blinking exclamation point appears next to the field. Hover over this error condition indicator to display the error text.

- The Set Defaults and Set Communication Option menu selections allow you to enter a wide variety of operational settings important to the NAE Update Tool. For more details, see Set Defaults menu selection and Set Communication Options menu selection.

Update processes

The NAE Update Tool offers the choice of three update processes: HTTP Only, PXE Only, or PXE or HTTP.

PXE Only is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later. The update selection is on the General Settings screen (Figure 26).

The NAE Update Tool cannot be used to update SNE and SNC engines.

Table 5: Update Processes

<table>
<thead>
<tr>
<th>Process</th>
<th>Characteristics of Selecting this Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>PXE or HTTP¹</td>
<td>Uses the PXE method for devices on the same subnet and the HTTP method for devices on other subnets.</td>
</tr>
<tr>
<td></td>
<td>Requires that you specify the MAC address.</td>
</tr>
<tr>
<td></td>
<td>Requires that you specify the Host Name.</td>
</tr>
<tr>
<td></td>
<td>Requires that the computer's MTU is set at 1500 bytes.</td>
</tr>
<tr>
<td>PXE Only</td>
<td>Updates NAEs across a single subnet.</td>
</tr>
<tr>
<td></td>
<td>Updates NAEs currently at Release 5.0 or earlier. If the NAE is at Release 4.1 or earlier, you can either manually restart the device to begin the update, or command a restart through the engine user interface.</td>
</tr>
<tr>
<td></td>
<td>Requires that you specify the MAC address.</td>
</tr>
<tr>
<td></td>
<td>Requires that the computer's MTU is set at 1500 bytes.</td>
</tr>
<tr>
<td></td>
<td>Updates an NAE that is not operational.</td>
</tr>
<tr>
<td></td>
<td>Updates NxE-25,35 and 45 devices at Release 9.0.7 and NxE-55xx-2 and 3 devices at Release 10.0 and later.</td>
</tr>
<tr>
<td>HTTP Only¹</td>
<td>Updates NAEs across multiple subnets. ¹</td>
</tr>
<tr>
<td></td>
<td>Updates NAEs on a secure network where SNMP trap messages are blocked. ¹</td>
</tr>
<tr>
<td></td>
<td>Updates NAEs currently at Release 5.0 or later.</td>
</tr>
<tr>
<td></td>
<td>Requires that you specify the Host Name.</td>
</tr>
<tr>
<td></td>
<td>Does not require that the computer's MTU is set at 1500 bytes.</td>
</tr>
</tbody>
</table>

¹ Do not use this option to upgrade NxE-25,35 and 45 devices to Release 9.0.7 or to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later; use PXE Only. The HTTP update process only applies to 9.0.1.x and earlier engines.
When you update an NAE using the PXE method and no DHCP server is present, the device may start up with an APIPA address (169.254.x.x). This address is incompatible with the NAE Update Tool computer’s IP address and prevents communication between the computer and the NAE. To enable communication, the NAE Update Tool temporarily adds an APIPA-compatible address to the wired Ethernet adapter that you selected when you started the tool (wireless adapters do not apply). When the NAE restarts after an update, it broadcasts an SNMP trap message that contains its current IP address to the NAE Update Tool. If it broadcasts an APIPA address, the tool assigns a compatible address to the Ethernet adapter (for example, 169.254.255.254), which enables communication between the NAE Update Tool computer and the NAE. Once the update is completed, the tool deletes this address from the adapter. The Log window captures these events.

Quick and extended update types

When you update an NAE35, NAE45, NCE25, or NIE29/39/49, you can select between two update types: Quick and Extended. The Quick update process:

• uses existing erased flash memory to quickly lay down the new image next to the old image
• applies only if there is enough erased flash memory in the device to hold both the old and new images
• applies only to NxEs at Release 6.0 or later
• takes about 15 minutes to complete

You cannot include user interface resources in a Quick update. The engine does not have enough erased flash memory to hold both the old and new images at the same time.

Note: The Quick Update process is not supported for loading a Release 9.0.7 image.

The Extended update process:

• erases all flash memory
• reorganizes the file system
• installs the new image
• takes about 30 minutes to complete

An Extended update is the most reliable way to update a device. An Extended update takes longer to complete than a Quick Update, particularly if you also download a UI resources file.

Notes:

• There is no UI resources file available to download to NxE-25,35 and 45 devices at Release 9.0.7. To obtain a file, you must either (a) view the device from its site director, (b) view another device at the same release to load the UI resource, or (c) manually load the UI resource.

• Only add the user interface resource files if the NAE35, NAE45, NCE25, or NIE29/39/49 is the only device that you login to at a specific release or the NAE is the Site Director.

• Use the Extended update the first time the NAE35, NAE45, NCE25 is updated to Release 6.5. You can use the Quick update process for subsequent Release 6.5 updates.

• The Quick and Extended update types do not apply to NAE55s, NIE55s, or NIE59s.
Set Defaults menu selection

The **Options > Set Defaults** menu selection allows you to specify general defaults for the tool. After you enter this information, any targets that are added use the new defaults; existing targets retain their old default values. You can change many of these settings globally by using the mass-edit option mentioned in *Characteristics of the NAE Update Tool*. As best practice, we encourage you to set as many defaults as possible. The option presents four tabs of information: **General Defaults**, **DHCP/Fixed IP Defaults**, **Login Defaults**, and **Site Director Default**.

General Defaults tab

The **General Defaults** tab (Figure 4) allows you to create an IP address space, enter an NAE description, select an NAE disk image, and select an update method.

**Figure 4: General Defaults Tab**

![General Defaults Tab](image)

**Table 6: Attribute/Selection Descriptions for General Defaults Tab**

<table>
<thead>
<tr>
<th>Attribute/Selection Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically create IP space (button) (^1)</td>
<td>Button you click to change the Base IP Address to a different range in the private 192.168 address space. To ensure that the tool generates a unique base IP address, the tool considers the MAC address of the installed network card.</td>
</tr>
<tr>
<td>Base IP address (^1)</td>
<td>First address to be assigned to a device that you are updating with the PXE method.</td>
</tr>
</tbody>
</table>
Table 6: Attribute/Selection Descriptions for General Defaults Tab

<table>
<thead>
<tr>
<th>Attribute/Selection Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address mask&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Mask to be applied to the base IP address.</td>
</tr>
<tr>
<td>IP address space size&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Number of addresses that the tool can assign. The base address plus this address space cannot exceed the subnet specified by the IP address mask. If any specified number is incorrect, a <strong>Default IP Space Error</strong> dialog box displays when you click <strong>OK</strong>. The default for this field is 254.</td>
</tr>
<tr>
<td>Description (NAE55/NIE55/NIE59)</td>
<td>Name to identify this NAE55/NIE55/NIE59.</td>
</tr>
<tr>
<td>Disk image (NAE55/NIE55/NIE59)</td>
<td>Disk image to download to this NAE55/NIE55/NIE59. Click [ ] to open the <strong>Select disk image</strong> dialog box and select the default disk image files for your NxE targets. The file name extension for the NxE55 or NxE59 depends on its model (Figure 5).</td>
</tr>
<tr>
<td>Description (NAE45/35/NCE25/NCM45/NIE29/39/49)</td>
<td>Name to identify this NAE45/35/NCE25/NCM45/NIE29/39/49</td>
</tr>
<tr>
<td>Disk image (NAE45/35/NCE25/NCM45/NIE29/39/49)</td>
<td>Disk image to download to this NAE45/35/NCE25/NCM45/NIE29/39/49 (.n402) file. Click [ ] to open the <strong>Select disk image</strong> dialog box and select the default disk image files for your NxE targets.</td>
</tr>
</tbody>
</table>

**Update Process To Use**

Type of process the tool uses to update the device.

**Note:**
- **PXE Only** is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later.
- The NAE Update Tool cannot be used to update SNE and SNC engines.

<table>
<thead>
<tr>
<th>Defaults for ARP caching behavior</th>
<th>Time (ms)</th>
<th>Cache Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time and cache limit for the Address Resolution Protocol (ARP) caching behavior. The cache is a table correlating MAC addresses to IP addresses. Change the default values only if working on a network where IP addresses change multiple times an hour. Defaults: Time (ms)=1800000 and Cache Limit=4096.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<sup>1</sup> Use these parameters only when using the PXE stand-alone update method. See **Stand-Alone NAE update**.
Select Release to be Loaded dialog box

The Select Release to be Loaded dialog box displays the disk images available in the local disk image file. Figure 5 shows the disk images available in the local disk image for updating an NxE55 or NIE59 engine. The proper disk image file type (.dsk, .dn2, .exe or .bz2) that you select is automatically verified by the MAC address you enter for the NAE55 or NIE59 target in the Add new update target screen (Quick start reference) or the Edit update target screen (Figure 36). See Detailed procedures for more information.

Figure 5: Select Release to be Loaded Dialog Box

<table>
<thead>
<tr>
<th>Select disk image from CANAEUpdateToolsftpfiles:</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAE55NIE55_10.0.0.1004.tar.bz2</td>
</tr>
</tbody>
</table>

Select a .dsk file if your device is a NxE55xx-0/1 or a .dn2 if it is a NxE55xx-2 or a .exe if it is a NxE55xx-3.

<table>
<thead>
<tr>
<th>File name:</th>
<th>Open</th>
</tr>
</thead>
<tbody>
<tr>
<td>File of type: DSK, DN2, EXE and BZ2 Files (<em>.</em>.dsk *.dn2 *.exe *.bz2)</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

DHCP/Fixed IP Defaults tab

The DHCP/Fixed IP Defaults tab allows you to enable DHCP or specify fixed IP address information for NAE targets.
**Table 7: Attribute/Selection Descriptions for DHCP/Fixed IP Defaults Tab**

<table>
<thead>
<tr>
<th>Attribute/Selection Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable DHCP (check box)</td>
<td>Check box to indicate if the NAE is assigned an IP address from a DHCP server on the network. If you clear this selection, the last three attributes become editable.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Cannot be edited because the IP address of each NAE must be unique.</td>
</tr>
<tr>
<td>IP Mask</td>
<td>IP address mask associated with the IP address.</td>
</tr>
<tr>
<td>IP Router Address</td>
<td>IP address of the router (default gateway) on the network.</td>
</tr>
<tr>
<td>DNS Server IP Address</td>
<td>IP address of the DNS server on the network.</td>
</tr>
</tbody>
</table>

**Login Defaults tab**

The **Login Defaults** tab allows you to specify a default user name and password for logging into an NAE from the NAE Update Tool. This login information is applied to each new device you add to the Target List. Existing targets use their current values.
Table 8: Attribute Descriptions for Login Defaults Tab

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>User name that is used to login to a device. Default user name is MetasysSysAgent.</td>
</tr>
<tr>
<td>Password</td>
<td>Password that is used to login to a device. Note: The default password for the MetasysSysAgent user at Release 6.0 or later is different from previous releases. For more information, contact your local Johnson Controls representative.</td>
</tr>
</tbody>
</table>

Site Director Default tab

The Site Director Default tab allows you to specify the Site Director that is used as the default when adding NAE targets.
The Set Communication Options menu selection allows you to set various communication parameters that are important to the functionality of the NAE Update Tool. The tool presents three tabs of information: **Timeouts**, **Reset Times**, and **Test MTU**.

- **Important:** Change the communication parameters only if they conflict with the customer's network. The default settings should work well for most installations. If you make any changes, and then need to revert to the original settings, click **Use Defaults**.

**Timeouts tab**

The **Timeouts** tab allows you to specify various wait times that the tool uses for PXE and HTTP updates.
Figure 9: Timeouts Tab

![Communications Options]

Table 9: Attribute Descriptions for Timeouts Tab

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Login Timeout (seconds)</td>
<td>How much time to wait for the device to respond after you click the Test Login Before Update button. If the device does not respond within this time period, a Test Login Error appears to indicate the device is offline.</td>
</tr>
<tr>
<td>PXE Timeout Discovery (seconds)</td>
<td>How much time to wait for a PXE process discover message response.</td>
</tr>
<tr>
<td>PXE Timeout Download (seconds)</td>
<td>How much time to wait before retrying a TFTP packet transmission.</td>
</tr>
<tr>
<td>PXE Max Retries</td>
<td>Number of times the NAE Update Tool retries a TFTP packet transmission.</td>
</tr>
<tr>
<td>HTTP Timeout Download (seconds)</td>
<td>How much time to wait before retrying an HTTP packet transmission.</td>
</tr>
</tbody>
</table>

Reset Times tab

The Reset Times tab allows you to adjust reset times for the various NAE devices and the Site Director. These reset times control how long the tool waits before trying to communicate to a device after a reset. They are also equivalent to the expected reset times reported in the Log. In
most situations, use the default settings. Changed settings should differ by no more than 10% of
the default value.

**Note:** Changes to reset time values are maintained with the NAE Update Tool. Therefore, if
default values are needed for the next site, click **Use Defaults** to restore default time values
for all values in the group.

**Figure 10: Reset Times Tab**

![Reset Times Tab](image)

**Table 10: Attribute Descriptions for Reset Times Tab**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Reset Time NAE45-x/NAE35-x/NCE-25x/NIE29/39/49-x targets (seconds)</td>
<td>This attribute indicates the number of seconds the tool waits (after transferring all files) before checking if the device is online and operational.</td>
</tr>
<tr>
<td>Update Reset Time NAE55-x/NIE55-x 256MB targets (seconds)</td>
<td>How many seconds the tool waits (after transferring all files) before checking if the device is online and operational. Applies to NAEs with 256 MB flash memory (NxE55xx-0 models).</td>
</tr>
</tbody>
</table>
### Table 10: Attribute Descriptions for Reset Times Tab

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Reset Time NAE55-x/NIE55-x/NIE59-x 512MB targets (seconds)</td>
<td>How many seconds the tool waits (after transferring all files) before checking if the device is online and operational. Applies to NAEs with 512 MB flash memory (NxE55xx-1 models). <strong>Note:</strong> For NxE55xx-2, NIE59-2, NxE55xx-3, and NIE59-3 models, the Update Reset Time is fixed and does not require adjustment.</td>
</tr>
<tr>
<td>Site Director Reset Time NAE45-x/NAE35-x/NCE-25x/NIE29/39/49-x targets (seconds)</td>
<td>How many seconds the tool waits before checking whether several NAE45/NAE35/NCE25/NIE29/39/49 configuration settings are correct, including the Host Name, Site Director name, IP address settings, and release level.</td>
</tr>
<tr>
<td>Site Director Reset Time NAE55-x/NIE55-x/NIE59-x targets (seconds)</td>
<td>How many seconds the tool waits before checking whether several NAE55/NIE55/NIE59 configuration settings are correct, including the Host Name, Site Director name, IP address settings, and release level.</td>
</tr>
<tr>
<td>Post Transfer Online Checks</td>
<td>How many times the tool checks if the device is online and operational. This attribute serves as a safety measure in case the reset time is set too short. If the retry attempts expire, the update fails. The tool waits approximately 10 seconds between each retry, with each retry taking 30 seconds or more.</td>
</tr>
</tbody>
</table>

### Test MTU tab

To test whether the MTU setting on your computer is correct, select the **Test MTU** tab. The MTU setting uses the PXE method to update NAE55/NIE55/NIE59 devices and NAE45/NAE35/NAE25 devices with UI resources. To initiate the test, enter a device name or IP address, and then click **Test MTU**. A message box indicates whether the MTU test passed.
Figure 11: Test MTU Tab

The Diagnostic Log window is a chronological list of events that have occurred during the current NAE Update Tool session. It operates in regular and advanced modes.

Regular mode

To enable Regular Mode, deselect the Advanced Mode option in the Options menu. In Regular Mode, the Log displays only the start time, completion time, and success or failure of each update. Details for each device are displayed in the Details field in the Target List.

Figure 12: Diagnostic Log Window for Regular Mode
Advanced mode

To enable the Advanced mode, select the Advanced Mode option in the Options menu. In advanced mode, the log shows details of every operation that occurs during the update, including every DHCP discovery message on the network. The information shown in the log window for a particular device also appears in the Details window for that device.

Figure 13: Diagnostic Log Window for Advanced Mode

Diagnostic Log operations

To save the contents of the log to a text file, select File > Save Diagnostic Log. The default format for naming the file is:

NUTLog<year><month><day>-<time of day>.txt

Example for October 10, 2012, at 8:15 A.M.:

NUTLog20121010-0815.txt

You can clear the log contents by selecting Options > Clear Log Window.

You can have the log window scroll automatically (default) or not scroll. Select Options > Automatically Scroll Log Window.

Note: The tool saves the contents of the diagnostic log window automatically. For details, see Auto-Saving NAE log files.

Auto-Saving NAE log files

Each time you close the NAE Update Tool the contents of both the Diagnostic Log window and Details window of each NAE you update archive to text files. The default location for these text files is C:\NAEUpdateTool\tftpfiles.
The Diagnostic Log file is named NUTLog_Autosave.txt and the individual NAE log files are named <Host Name>_detailsAutosave.txt. You can view these files with any text editor. The files remain in the NAE Update Tool folder until you delete them. The tool replaces the Diagnostic Log file the next time that the tool is run and replaces the NAE Details Log file the next time that the device is updated.

NAE update stages and timelines

Each model of the NAE has different stages and takes a longer or shorter time to update. This section describes the stages and indicates the update times for each model.

NAE35/NAE45/NCE25/NIE29/39/49 update stages and timeline

About this task:
Depending on which type of update is performed (Quick or Extended) and whether the User Interface Resources file is installed, the NAE goes through the following stages during its update process (times vary slightly by model):

1. The Metasys .bin file is downloaded.
2. The operating system is installed.
3. The user interface resource file (.gz) is downloaded.
4. The user interface resource file is extracted.
5. The Metasys software .n402 file is downloaded.
6. The Metasys software is installed. Metasys Installing appears in the Progress column of the Main screen and a File Transfer Complete status message appears in the Log. The tool also indicates the expected reset time.
7. The Site Director, Host Name, and fixed IP Address are written to the NAE if you specified these values on the General Settings screen. The old flash memory is erased during this process.
8. The NAE restarts. The NAE is ready and accessible when the Post File Transfer Complete message for the device appears in the Log.

Figure 14: NAE35/NAE45/NCE25/NIE29/39/49 Extended Update Timeline

Note: This process takes longer if you choose to download a resource file. Metasys resource files cannot be downloaded to NxE-25,35 and 45 devices at Release 9.0.7. To obtain a file for this release you must either (a) view the device from its site director, (b) view another device at the same release to load the UI resource, or (c) manually load the UI resource.
Figure 15: NAE35/NAE45/NCE25/NIE29/39/49 Quick Update Timeline

Note: The Quick Update process is not supported for loading a Release 9.0.7 image.

NAE55/NIE55/NIE59 update stages and timeline

About this task:
The NAE goes through the following stages (Figure 16) during the update:

1. The operating system is downloaded and installed.
2. The Metasyst software is downloaded and installed.
3. Metasyst Installing appears in the Progress column of the Main screen, and a File Transfer Complete status message appears in the log. An expected reset time message also appears.
4. The NAE restarts multiple times, one extra time if you specified a Site Director or static IP address. Do not remove power from the NAE during the restart process. The NAE is ready and accessible when the Post File Transfer Complete message for the device appears in the log.
Note: The update timelines displayed in Figure 16 are the same for both the NxE55xx-x and NIE59-x.

When to exit the tool

We recommend that you keep the NAE Update Tool running until **Completed** appears in the **Status** column for each updated device. Although you can exit the tool as soon as the **Metasys Installing** status appears in the **Progress** column, if you exit the tool at this stage the Writing Attributes and Reset step does not execute, and the specified NAE name, static IP address, and Site Director name are not configured.

Detailed procedures

This section provides detailed steps for the following procedures:

- Configuring Windows Firewall
- Extracting the engine images to your computer
- Preparing the computer and NAE
- Updating an NAE or migrating an NAE45-2 to an NCM45-2

Configuring Windows Firewall
About this task:
If you want to use the NAE Update Tool on a computer that is running any supported edition of Windows 10, Windows 8.1, Windows 8, Windows Server 2016, Windows Server 2012 R2, or Windows Server 2012, configure Windows Firewall following the procedure outlined in this section. These steps enable reliable network communication between the NAE Update Tool and the supervisory engines.

Note: Starting at Release 7.0, when you start the NAE Update Tool, Windows or third-party firewall information and a list of ports that you need to open appear in the diagnostic window.

Figure 17: Third-Party Firewall and Ports Information

![FirewallEnabled - The following active firewalls have been detected: Symantec Endpoint Protection Please make certain that the following ports are open for use: 67, 68, 69, 80, 162, 9910, and 9911.]

To check if Windows Firewall is on, complete the following steps:

1. In Control Panel, click System and Security, and then click Windows Firewall.

The Windows Firewall window appears (Figure 18).

2. If Windows Firewall is On, the firewall is active. To configure the firewall, continue to Step 3.

Figure 18: Windows Firewall On – Windows 7 Example

![Windows Firewall state: Connected]

If you are prompted to update your firewall settings (Figure 19), Windows Firewall is off and another firewall may be active. Check the firewall’s documentation to make certain inbound IIS port 80 traffic is not blocked. If no firewall is active, turn on Windows Firewall and continue to step 3.
3. In the left pane of the Windows Firewall window, click **Advanced Settings**. The **Windows Firewall with Advanced Security** window appears.

![Windows Firewall Off - Windows 7 Example](image1)

**Figure 19:** Windows Firewall Off - Windows 7 Example

4. In the left pane, click **Inbound Rules**. The **Inbound Rules** pane appears.

![Windows Firewall with Advanced Security](image2)

**Figure 20:** Windows Firewall with Advanced Security
5. In the Inbound Rules pane, click World Wide Web Services (HTTP Traffic-In).

6. In the Actions pane, click Enable Rule. The World Wide Web Services (HTTP Traffic-In) Inbound Rule is enabled.

8. In the **General** tab of the **World Wide Web Services (HTTP Traffic-In) Properties** window, select the **Enabled** check box and select the **Allow the Connection** option.

9. To save this change, click **OK**.

10. Close all windows.

**Notes:**

- To configure a third-party firewall, refer to the manufacturer's instructions.

- For complete firewall setup instructions, refer to *SCT Installation and Upgrade Instructions (LIT-12012067)*.

**Extracting the engine images to your computer**

To extract the engine images to your computer, complete the following steps:

1. Obtain the required engine image from the Johnson Controls License Portal.
2. Double-click the appropriate file using Table 11. The **Metasys Engine Importer** extracts the contents of the file to **C:\NAEUpdateTool\tftpfiles**.

3. Click **Finish** to complete the process.

4. Go to **Preparing the computer and NAE**.

**Note:**
- For added security, N40 and N50 disk images are encrypted. The NAE Update Tool decrypts these image files when transferring the image files to a device.
- NIEx9s only support disk images for Release 7.0 or later.

### Table 11: Image Files

<table>
<thead>
<tr>
<th>Engine</th>
<th>File Name</th>
<th>File Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAE35-1, NAE35-2</td>
<td>NAE45-NAE35-NAE45-1</td>
<td>NAE45-NAE35-NCE25_9.0.7.xxxx.emage</td>
</tr>
<tr>
<td>NCE25-0, NIE49-2</td>
<td>NIE39-2, NIE29-0</td>
<td>NCE25_9.0.7.xxxx.mei</td>
</tr>
<tr>
<td></td>
<td>NAE45-NCE25-NCE25_9.0.7.xxxx.n402</td>
<td>NAE45-NCE25-NCE25_9.0.7.xxxx.n402</td>
</tr>
<tr>
<td></td>
<td>Turboboot_9.0.7.xxxx.etb</td>
<td>Turboboot_9.0.7.xxxx.etb</td>
</tr>
<tr>
<td>NAE55-2</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-10.1.0.xxxx.mei</td>
</tr>
<tr>
<td>NIE55-2</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
</tr>
<tr>
<td>NIE55-2</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
</tr>
<tr>
<td>NIE59-2</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
</tr>
<tr>
<td>NIE59-3</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
</tr>
<tr>
<td>NIE59-3</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
</tr>
<tr>
<td></td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
<td>NAE55-NIE55-10.1.0.xxxx.mei</td>
</tr>
</tbody>
</table>

### Preparing the computer and NAE

#### About this task:
Note:

- If you are migrating an NCM45-2 to an NAE45-2, skip Step 1.
- You no longer need to use the NAE Configuration tool during an update. The log window of the NAE Update Tool reports the same information.

To prepare the computer and NAE, complete the following steps:

1. Back up the existing database in the NAE. Refer to the Metasys SCT Help (LIT-12011964) for details.

2. If you have the MCI Access Manager Client installed on your computer:
   a. On the Start menu, select Programs>Cisco Systems VPN Client>Set MTU.
   b. Select Local Network Connection.
   c. Select the button next to Custom.
   d. Type 1500 in the Custom field.
   e. Click OK.

3. If you have the Cisco AnyConnect VPN Client installed on your computer, complete the following steps:
   a. Click the Start button and select All Programs>Accessories. Right-click Command Prompt and click Run as Administrator. The Command Prompt window appears.
   b. To show the MTU for all adapters, type netsh interface ipv4 show interfaces, and then press Enter. A few seconds later, a table appears indicating the current MTU values.

   For example:

<table>
<thead>
<tr>
<th>Idx</th>
<th>Met</th>
<th>MTU</th>
<th>State</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>50</td>
<td>4294967295</td>
<td>connected</td>
<td>Loopback Pseudo-Interface 1</td>
</tr>
<tr>
<td>14</td>
<td>25</td>
<td>1500</td>
<td>disconnected</td>
<td>Wireless Network Connection</td>
</tr>
<tr>
<td>12</td>
<td>20</td>
<td>1400</td>
<td>connected</td>
<td>Local Area Connection</td>
</tr>
<tr>
<td>29</td>
<td>20</td>
<td>1500</td>
<td>connected</td>
<td>VirtualBox Host-Only Network</td>
</tr>
</tbody>
</table>

   c. Find the network connection you will select when performing the NAE update. Verify the MTU value is 1500. You do not need to verify any other connections, just the one the NAE Update Tool uses.
   d. If the value is 1500, no further action is needed. If the value is less than 1500, type the following command in the command window and press Enter: netsh interface ipv4 set subinterface "Local Area Connection" mtu=1500 store=persistent. The "Local Area Connection" should be replaced with the connection name identified in the table. The quotation marks on either side of the connection name are required.
   e. Close the Command Prompt window and restart your computer. The MTU for the Local Area connection is now configured for 1500.

4. Turn off any firewalls that are enabled in the VPN clients on your computer.

   For example, for Cisco Systems VPN Client:
   a. On the Start menu, select Programs > Cisco Systems VPN Client > VPN Client.
   b. On the Options menu, ensure that the Stateful Firewall (Always On) check box is not selected.
5. Using the SMP UI, verify that the NAE is online and operational. Beginning an update with the Start Update button requires a device login, which fails for an NAE that is not operational. For more details, see Adding NAE update targets.

Updating an NAE or migrating an NAE45-2 to an NCM45-2

If you are updating an NAE, or migrating an NAE45-2 to an NCM45-2, follow the steps covered in Adding NAE update targets and Updating NAE targets.

Adding NAE update targets

To add an NAE update target, complete the following steps:

1. On the Start menu, select Programs > Johnson Controls > Metasys > NAE Update Tool. If your computer has more than one network card, the Select Ethernet Adapter screen appears (Figure 23), listing the network cards that you can use to perform the update. The Ethernet adapter descriptions come from the operating system’s Device Manager.

   Note: If any of these network cards are disabled, have not acquired an IP address, or if the patch cable is not properly connected, an IP Address of 0.0.0.0 appears. In this case, either do not select this card or enable the card and restart the NAE Update Tool. Also, check the patch cable connection. If it is not connected, reconnect it correctly, and then restart the NAE Update Tool.

   Figure 23: Ethernet Adapter Selection Screen

2. Select the network card you want to use and click OK. (The network card must have a non-zero IP address). The NAE Update Tool Main screen appears showing the NAEs you have configured, if any. See Figure 24.

   Note: If you have not configured any NAEs, the top section of the screen (Target list) appears blank.
3. On the NAE/NCE menu of the NAE Update Tool, select the **Add** option, and select the type of NAE you wish to update (Figure 25).

Figure 25: NAE/NCE Menu

4. Specify the information for the Target device to be updated.

Figure 26: Entering Target Device Information

- **Description:** Enter a description that is used by the NAE Update Tool to help you identify the NAE (optional).
- **MAC address**: Enter the MAC address for the NAE (with or without dashes) or use the Test Login procedure and the MAC address automatically populates. See [Determining the MAC address of an NAE](#). The MAC address is required for PXE updates.

  🔄 **Note**: When you enter the MAC address for NxS55-x engines, the NAE Update Tool automatically determines which image file type (.n402, .rgz, .dsk, .dn2, .exe, .bz2) is required. See Figure 28 for more information.

- **Host Name**: Enter the desired value for the Computer Name attribute of the NAE (up to 15 characters) or use the Test Login procedure and the Host Name fills automatically. The name is assigned to the NAE at the end of the update process. This name must be unique in the Site Management Portal (SMP) UI site. If you leave this field blank, the Computer Name attribute defaults to NAExxxxxxxxxxx, where xxxxxxxxxxxxx is the unique MAC address.

  **Notes**:
  - The Host Name is not required when using the **PXE Only** update method.
  - If you decide to change the Computer Name after the update, you must reset the NAE an additional time.

- **Status**: Verify that the **Status** is **Enabled**. Do not select the **Missing File** option, which indicates that an invalid image file has been selected for the NAE. The field changes to **Enabled** when a valid image file is selected.

5. If the device is an NAE35, NAE45, NCE25, NIE29, NIE39, or NIE49, specify the update type and select the **Add UI Resources** check-box if you need to add a user interface resource file with the update. These selections do not apply to NAE55s, NIE55s, or NIE59s. See Figure 27.

- **Quick**: Select **Quick** for all standard updates (default). A **Quick** update uses existing erased flash memory to quickly lay down the new image next to the old image and takes approximately 15 minutes to finish.

- **Extended**: Select the **Extended** check-box to erase all flash memory, reorganize the file system, and install the new image. If you select the **Add UI Resources** check-box, the **Extended** check-box is selected automatically. An **Extended** update takes approximately 30 minutes to finish.

- **Add UI Resources**: Downloads the **Metasys** resource file. If you select **Quick** update and launch the SMP UI from an ADS/ADX Site Director, you do not need to add user interface resources.

  **Notes**:
  - The **Quick Update** process is not supported for loading a Release 9.0.7 image.
  - There is no **Metasys** resource file available to download to NxS-25,35 and 45 devices at Release 9.0.7. To obtain a file you must either (a) view the device from its site director, (b) view another device at the same release to load the UI resource, or (c) manually load the UI resource.
6. In the **File** section, click and select the correct file using Table 11

**Figure 28: Specifying a File**

![Image showing file selection](image)

7. In the **Enable DHCP or Fixed IP Address Information** section, specify the following values:

   - **Enable DHCP (Check Box):** If the NAE obtains its IP address from a DHCP server on the network (default), select Enable DHCP. If the NAE is assigned a static IP address, click to clear the Enable DHCP check box. When you clear this option, the next four fields become editable.

   - **IP Mask:** If DHCP is not enabled, enter appropriate values for these attributes. You can retrieve these fields from the device if you click **Test Login Before Update**. These IP entries are written to the device at the end of the update, saving you the step of doing so manually.

**Figure 29: Specifying DHCP and Fixed IP Address Information**

![Image showing DHCP and IP address information](image)

8. Enter the name of the site director for the NAE. The site director that you specify is assigned to the NAE once the update is complete. This saves you the step of making this assignment once the NAE is updated, but involves an extra reset during the update process. Do not enter the IP address of the NAE that you are updating in the **Set Site Director** field.

   - **Note:** The **Set Site Director** field is disabled when a Release 10.0 or later image is selected.

**Figure 30: Specifying the Site Director**

![Image showing site director setting](image)
9. Specify the update process to use. In most cases, select **PXE or HTTP (update devices in any subnet)**. Only select one of the other two options if directed to do so by technical support or if the other choice did not work.

   ☀ **Note:**

   - The PXE process requires that you specify a MAC address. The HTTP process requires that you specify a Host Name. If you select the PXE or HTTP update process, you must specify both a MAC address and a Host name.

   - **PXE Only** is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later.

   - The NAE Update Tool cannot be used to update SNE and SNC engines.

**Figure 31: Specifying the Update Process to Use**

![Update Process To Use](image)

10. If the HTTP process is used or you wish to test logging into the device, specify the login information for the NAE. See Figure 32 and **Testing login before updating NAE**.

   - **User Name** and **Password**: Specify a valid user name and a valid password to access the device. You can use the MetasysSysAgent user with its current password. Note that the default password for the MetasysSysAgent user changed at Release 6.0. For more information, contact your local Johnson Controls representative.

   - **Test Login Before Update (Button)**: Click this button to test whether you can login to the device. If Test Login fails using configured values, enter the current Host Name or IP Address here. If you cannot communicate with the device using the specified Host Name or IP Address, enter its current Host Name or IP Address here.

**Figure 32: Specifying the Login Information**

![Login Information for HTTP Update Process or to remotely start the update](image)

11. After you have entered all necessary fields, click **OK** to save. The NAE is now ready for the update. Go to **Updating NAE targets**.

**Testing login before updating NAE**

**About this task:**

To test if you can login to an NAE before you update it, complete the following steps:

1. On the Main screen of the NAE Update Tool, double-click an NAE.
2. In the **Edit update target** dialog box (Figure 36), specify a valid user name and password, and click **Test Login Before Update**. The NAE Update Tool attempts to login with the credentials you specified. A few seconds later, a **Login result** dialog box appears (Figure 33).

Figure 33: Login Result Dialog Box

![Login Result Dialog Box](image)

If login is successful, the message **Login succeeded** appears in the dialog box. If login is not successful, the message reads **Login failed**. The **Details** portion of the dialog box indicates a reason for the failure. You can try again, this time specifying the current Host Name or IP Address of the device in the field next to the **Test Login Before Update** button. If login is successful, but the MTU setting is not correct for the NAE, the message in Figure 34 appears:

Figure 34: Warning Message Indicating Incorrect MTU Setting

![Warning Message](image)

If DHCP is not enabled for the device, the NAE Update Tool retrieves the IP Address and MAC Address from the device during the login process. The tool verifies that these retrieved addresses match the IP and MAC Addresses in the **Edit update target** dialog box (Figure 36). During the login process, the NAE Update Tool reads the Host Name, the MAC address, and all fixed IP address fields. If any of these values differ from what is configured in the NAE Update Tool, you are presented with a **Warning** dialog box asking whether you want to replace the configured values. Figure 35 shows an example. To match the values and ensure a successful update click **Yes**. To abort the update, click **No**.
When you click Test Login Before Update for an NAE35, NAE45, NCE25, or NIE29/39/49, the tool automatically determines whether the device has enough flash memory to qualify for a Quick update.

If the device has the required amount of flash memory, the following message appears in the Details Log: Information - Quick mode may be selected for this device (<NAE name>). In this case, you may use the Quick update option.

If the device does not have the required amount of flash memory, the following message appears in the Details Log: Information - There is not enough available flash in this device (<NAE name>) for a Quick update to be performed. In this case, an Extended update is required and the Extended update option is automatically selected.

If the test login process fails, make sure that you specified the current password for the MetasysSysAgent user. For Release 6.1 and later, you must use the new default password. For NAEs at an earlier release, you must use the existing password for the MetasysSysAgent user. If you need to change the current password for many NAEs at the same time, use the mass-edit option mentioned in Characteristics.

Updating NAE targets

Notes:

• If a PXE server is on the network, you must disconnect the NAE from the network for the update to occur. For details, see Stand-Alone NAE update.

• You cannot update the NAE55-0 and NAE45-0 models with Release 4.1 or later firmware. If you try to do so, the following text appears in the Diagnostic Log window shortly after you start the update: 512 MB of Flash Storage is required for this release. Please contact your Johnson Controls representative for upgrade options. Also, the Status field for this NAE changes to Disabled.

To update NAE targets, complete the following steps:

1. If the tool is not yet running, on the Start menu, select Programs > Johnson Controls > Metasys > NAE Update Tool. The NAE Update Tool main screen appears, showing the NAE targets you have already configured.

   Note: If you have not configured any NAE targets, the top section of the screen (Target section) appears blank. Go to Adding NAE update targets.
2. To see the most current log messages as they occur, click the **Automatically Scroll Log Window** in the **Options** menu.

**Note:** To save the contents of the NAE Update Tool log to a .txt file at any time in the process, select **File > Save Diagnostic Log**.

3. Make sure that the **Status** column entry for the NAE you are updating is **Enabled**.

**Note:** If the **Status** entry is not **Enabled**, double-click the row for the NAE that you want to update. The **Edit update target** screen appears (Figure 36). In the **Status** drop-down box, select **Enabled** and click **OK**.

4. Verify that your Ethernet connection is currently active and that you are able to reach the target NAEs using the ping command (at the command prompt) from the NAE Update Tool computer.

5. Verify that no one is currently logged into the SMP UI of the NAE. If so, log out before proceeding.

**Figure 36: Edit Update Target Dialog Box Contents (NAE45 Example)**
6. For each NAE that is currently at Release 4.1 or later, highlight the NAE in the Target list and click **Update Device**. The NAE receives the request and the update begins. If any of the selected NAEs is not **Enabled** for an update, a user message appears, indicating that this device is not to be updated.

For an NAE that is currently at Release 4.0 or earlier, do not use the **Update Device** option. Instead, perform a software reset of the device from the SMP UI: right-click the NAE on the Navigation tree, and then select **Commands > Reset Device**.

The NAE Update Tool detects the NAE restart and begins the update. The Log window shows the update progress (Figure 37). An **Update Complete** message in the login indicates a successful update. If any errors occur, see **Troubleshooting**.

- **Note:** During the entire update process, make sure that you do not exit the NAE Update Tool or turn off power to the NAE. Doing so could adversely affect the update process.

For a summary of the stages that the NAE goes through, see **NAE35/NAE45/NCE25/NIE29/39/49 update stages and timeline** and **NAE55/NIE55/NIE59 update stages and timeline**.

**Figure 37: Successful Log Example – Advanced Mode (NAE45-x)**

- **Note:** The example in Figure 37 shows the typical update messages that you can expect, but it does not match the set of messages you may receive. Any messages that contain the words **via host** and an IP address indicate the address of the device that is being updated.

7. When the Status column for the NAE indicates **Completed**, login to the newly updated NAE by using the IP address displayed in the log portion of the tool.
Note the recommended checks and options, as follows:

- Verify that the time, time zone, and date of the NAE match what is expected. The NAE Update Tool does not set the device’s time zone. If you specify an ADS in the Target window, the NAE receives the appropriate time zone and date information from the ADS. If you did not specify an ADS, you may need to download the NAE with this information.

- You can change the NAE Host Name from its current setting, unless you made this change before you started the update. See Figure 26.

- You must change the NAE IP address if you are using static IP addressing, unless you made this change before you started the update. See Figure 29.

Notes:

- These adjustments are required to make sure that the SCT can communicate with the newly updated NAE.

- If you change the NAE Host Name at this step, you must reset the NAE.

8. If you had the Serial Printer DDA installed on the NAE, reinstall it. Refer to the NAE Commissioning Guide (LIT-1201519).

9. Close the NAE Update Tool session. The disk image update is complete.

Note: If you are upgrading, refer to the Metasys Server Installation and Upgrade Instructions (LIT-12012162) for details on the rest of the upgrade process, including downloading the database from the SCT.

Load Target List from SCT archive

This new menu option in the NAE Update Tool populates the user interface with code-loadable devices from an archive in the System Configuration Tool (SCT).

The purpose of the menu option is to save time for a field technician who experiences a problem downloading a device using the SCT.
This feature works only for devices that have been uploaded into the SCT, since the required device MAC address is only obtained through an upload. A technician normally uploads a site before upgrading it.

1. From the File menu, click **Load Target List From SCT Archive**.

   **Figure 38: New Menu Option**

   ![New Menu Option](image)

   **Note:** An **Invalid Credentials** alert appears if the NAE Update Tool cannot open an SCT Archive.

2. Enter your username and password, then click **Read Archive List**. The **Archive List** is populated with entries from the SCT database in alphabetical order.

   **Figure 39: SCT Archive Dialog Box**

   ![SCT Archive Dialog Box](image)

3. Select an archive from the list, then click **Read Device List From Archive** to populate the user interface with the devices in the archive.
After all code-loadable devices are read, they appear in the tool with a **Disabled** status. You can enable devices that failed the download and then use the **PXE Only** method to download those devices.

⚠️ **Note:** Any items found in the archive that cannot be code-loaded are listed in the tool’s log window.

⚠️ **Note:** When you click **Read Device List From Archive**, you are prompted to save the current device list if changes have been made.

**Troubleshooting**

The fact that an NAE communicates with the Site Director and displays an Online status in the SMP UI does not guarantee that you can update this NAE with the NAE Update Tool over the network. The NAE Update Tool employs a primitive level of communication that does not include lengthened timeouts and full error handling.

If a problem occurs during an update, click **Details** (Figure 3) to show a list of all operations performed. This information helps with problem diagnosis. If the update process fails, repeat the
update process from the beginning. If the second update attempt also fails, see Stand-Alone NAE update.

To troubleshoot problems with the NAE Update Tool, see Table 12 in General troubleshooting.

**General troubleshooting**

**Table 12: List of Possible Problems with Solutions**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The NAE Update Tool fails to launch. In the Windows Event Log, located</td>
<td>Disable IPv6 on the network adapter you intend to use prior to starting the NAE Update Tool. To disable IPv6, go to Start &gt; Control Panel &gt; Network and Internet &gt; Network and Sharing Center &gt; Change Adapter Settings. Right-click the network adapter and select Properties. In the Networking tab, deselect the Internet Protocol Version 6 (TCP/IPv6) check box. Once you are finished using the NAE Update Tool, re-enable IPv6 on the adapter.</td>
</tr>
<tr>
<td>in Start &gt; Control Panel &gt; System and Security &gt; Administrative Tools</td>
<td></td>
</tr>
<tr>
<td>&gt; Event Viewer &gt; Saved Logs &gt; Event Log, an application error message displays.</td>
<td></td>
</tr>
<tr>
<td>The WinPoET for Windows application is interfering with the NAE Update</td>
<td>The WinPoET application is a Point-to-Point Protocol over Ethernet (PPPoE) application that is often distributed by digital subscriber line (DSL) providers for authentication and other purposes. If this application is installed, the NAE Update Tool does not work correctly. Removing the WinPoET application using Add or remove programs does not fully remove the WinPoET application from a system. An application called KILLPOET completely removes the application from the system and is usually available from your Internet service provider. Please contact your ISP if you need help with this application.</td>
</tr>
<tr>
<td>Tool.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 12: List of Possible Problems with Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The update process does not initiate.</td>
<td>Check the following:</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the NAE is connected to the network and is accessible online. See <a href="#">Updating an NAE or migrating an NAE45-2 to an NCM45-2</a>. Alternatively, follow the stand-alone update process steps documented in <a href="#">Stand-Alone NAE update</a>.</td>
</tr>
<tr>
<td></td>
<td>• If you are using the stand-alone update process, make sure that the Ethernet patch cable is connected to the NAE and that the NAE is receiving power when you start using the NAE Update Tool.</td>
</tr>
<tr>
<td></td>
<td>• Check that the LAN connection on the computer running the NAE Update Tool is enabled and that all other connections are disabled. See Step 4 in <a href="#">Connecting the NAE to the ethernet switch</a>.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that you have the correct update method selected for the NAE. For example, initiating an update with the <code>Start Update</code> button does not work if <code>PXE Only</code> is selected or if the NAE is currently at Release 4.0 or earlier. See <a href="#">Three methods for updating network engines</a>.</td>
</tr>
<tr>
<td>Transfer of files is incomplete during an update using the NAE Update Tool.</td>
<td>This problem could be caused by one of the following:</td>
</tr>
<tr>
<td></td>
<td>• The laptop computer loses power or has insufficient battery charge to complete the update. Plug in the external power adapter to an AC power source. We do not recommend that you run the NAE Update Tool computer on battery power. If the low battery message appears, you cannot see it because it appears behind the NAE Update Tool screen. Restart the update process.</td>
</tr>
<tr>
<td></td>
<td>• The wired or wireless connection you are using is unreliable.</td>
</tr>
<tr>
<td>The update does not work with crossover cables.</td>
<td>The NAE update process is not supported with crossover cables. If you need to use the stand-alone update method, use recommended hardware according to <a href="#">Hardware requirements</a>.</td>
</tr>
<tr>
<td>RUN LED is not on steady and the PEER COM LED is not off or flickering.</td>
<td>The NAE has not completed the restart sequence. Wait for the <code>Post File Transfer Complete</code> message to appear for this engine in the NAE Update Tool log.</td>
</tr>
</tbody>
</table>
### Table 12: List of Possible Problems with Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you reset or remove power from the NAE, the NAE Update Tool log</td>
<td>Virtual Private Network firewalls interfere with NAE Update Tool operation, even if wireless connections are disabled. Check to see that firewalls are disabled for your VPN before you begin the update. For example, in the Cisco Systems VPN Client, under the Options menu, make sure Stateful Firewall (Always On) is not selected. If you have already attempted to update the engine, disable the VPN firewall and attempt the update again.</td>
</tr>
<tr>
<td>shows that the engine is repeatedly assigned the same IP address, and the</td>
<td>Part of the fixed IP address of the NAE might have been erased. This error could have occurred if someone used the current release of the NAE Update Tool to set a fixed IP address, and then downgraded the engine to Release 4.0 or earlier with an older release of the tool. To fix this problem, perform a PXE Only update to the NAE using the NAE Update Tool at the current Release.</td>
</tr>
<tr>
<td>GENL FAULT LED stays on longer than it should. If you attempt to remove</td>
<td>The NAE55 indicates that the image file was successfully transferred, so the tool waits for the engine to reset before responding to file requests. To fix this problem, perform a PXE Only update to the NAE using the NAE Update Tool at the current Release.</td>
</tr>
<tr>
<td>power or press the SYSTEM RE-BOOT switch, the log records that the engine</td>
<td>The NAE Update Tool repeatedly transfers the first set of NAE files (tbosloader, pxelinux.cfg, tbusimage, and tbramdisk) to an NAE.</td>
</tr>
<tr>
<td>is assigned the same IP address with each attempt.</td>
<td></td>
</tr>
<tr>
<td>The NAE Update Tool repeatedly transfers the first set of NAE files</td>
<td></td>
</tr>
<tr>
<td>(tbosloader, pxelinux.cfg, tbusimage, and tbramdisk) to an NAE.</td>
<td></td>
</tr>
<tr>
<td>The NAE Update Tool takes several hours to update an NAE55. The Details</td>
<td></td>
</tr>
<tr>
<td>field on the Main screen indicates an error transferring the image file.</td>
<td></td>
</tr>
</tbody>
</table>
Table 12: List of Possible Problems with Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Condition/Solution</th>
</tr>
</thead>
</table>
| The NAE Update Tool fails to start the download of the image file on a computer running Windows 10, Windows 8.1 or Windows 8. | IIS has shut down unexpectedly, perhaps because of changes to the default security permissions for Windows 10, Windows 8 or Windows 8.1. To verify that IIS is working, start Internet Explorer and go to http://localhost. If you do not see the Internet Information Services (IIS) screen, follow these steps:  
1. Start the Internet Information Services (IIS) Manager.  
2. Expand the computer account tree and click Application Pools.  
3. Right-click DefaultAppPool under the Application Pools table, and select Advanced Settings.  
4. On the Advanced Settings window, scroll to Load User Profile in the Process Model section.  
5. Set Load User Profile to False.  
6. Also in the Process Model section, set Identity to Network Service.  
7. Click OK to save the change.  
8. Under the Actions pane, click to stop, then start the Application Pool Tasks.  
9. Go to http://localhost with the web browser to verify IIS is working.  
10. Try to update the NAE again. |
<p>| The NAE Update Tool fails to shut down when you try to exit from the tool. | The Ethernet adapter that you selected when you started the NAE Update Tool may have lost connection to the network. End the program with Task Manager by right-clicking the Microsoft Windows toolbar, selecting Task Manager, and ending the NAE Update Tool program. Then, check your network connection. Also, as a general rule, do not enable or disable network connections while using the NAE Update Tool. |
| The Site object is missing from a newly updated NAE. A site object should exist. | You may have entered the IP address of the NAE you are updating in the Set Site Director field on the Edit update target window of the NAE Update Tool. A newly updated NAE is a Site Director by default, so no entry for Set Site Director is required for a device intended to be a Site Director. To resolve this issue, login to the device, clear the Local Site Director value, and then reset the device. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Condition/Solution</th>
</tr>
</thead>
</table>
| The Test Login procedure fails. | Do the following:  
  • Verify the specified user name and password are correct.  
  • Verify communication with the ping command at the command prompt to make sure the NAE Update Tool computer can reach the target engine. If using wireless, verify signal strength is excellent.  
  • Retry the **Test Login** option a second or third time. |
| The ping command does not work on my network. | The Internet Control Message Protocol (ICMP) might be disabled on your network. If ICMP is disabled, start the NAE update by manually resetting the engine while the computer running the NAE Update Tool is connected to the same network segment. In this situation, the **Start Update, Test MTU, and Test Login** functions may not work. The tool’s computer and NAE are on the same subnet if they share the same gateway router address. (You can determine whether the gateway router address is shared using the `ipconfig` command). |
| An update attempt fails and the engine stops communicating with the tool. | The network was disconnected long enough for the update to time out. The engine tries to communicate using the original connection, which is now closed. To fix this problem, perform a **PXE Only** update to the NAE using the NAE Update Tool. |
| The customer:  
  • Assigns a fixed IP address to an NAE  
  • Connects the NAE Update Tool computer and the engine to an Ethernet switch with no DHCP server.  
  • Tries to update to the same fixed IP address. After the update, the engine either has a 169.254.xxx.xxx address or resets continuously. | When the engine cannot find a DHCP server, it loses the fixed IP address. To fix this problem, perform a **PXE Only** update to the NAE using the NAE Update Tool. |
| Disk image file download to an NAE55, NIE55, or NIE59 fails approximately 5 minutes after download starts. The download then starts again, fails again, and repeats this download start and fail cycle every 5 minutes. | If the computer running the NAE Update Tool is not the Site Director, check to see if `DeviceManager.exe` is running on the computer. If `DeviceManager.exe` is running, use **Windows Task Manager** to stop the Device Manager process. (Do not stop the process if the NAE Update Tool computer is the Site Director, since the process is needed for site communication). |
Table 12: List of Possible Problems with Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Condition/Solution</th>
</tr>
</thead>
</table>
| During the update process, the specified IP address is not written back to the NAE and instead the NAE takes on a default address, resulting in a loss of communication between the NAE Update Tool computer and the NAE. | You may have chosen the **PXE Only** update method for updating the NAE on a secure site where unsolicited TCP messages are blocked. During the update process, the operating system blocked the SNMP Trap message because of its security settings; therefore, the NAE Update Tool did not receive the SNMP Trap message which notifies the tool that the NAE has restarted. If the **HTTP Only** update process was used, the NAE stores the static IP address and sets the address at the end of the update. To resolve this issue, select the **HTTP Only** update process in the NAE Update Tool for a computer that uses secure OS settings.  

**Note:**  
- **PXE Only** is the only update process that can be used to upgrade NxE-25, 35, and 45 devices to Release 9.0.7 and to upgrade NxE-55xx-2 and 3 devices to Release 10.0 and later.  
- The NAE Update Tool cannot be used to update SNE and SNC engines. |

Table 13: List of Possible Error and User Messages

<table>
<thead>
<tr>
<th>Error or User Message</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corrupt File.</td>
<td>This message appears in the <strong>Status</strong> column of the main screen if you load an invalid image file, or replace an existing file with an invalid one before NUT sends it to the device. To resolve the issue, replace the specified image file.</td>
</tr>
</tbody>
</table>

**The following requirements are not satisfied:**

- IIS is not installed. Metasys NAE Update Tool requires IIS 5.1 or higher.  
- Run setup again when the above problems are resolved.  
- Please see C:\Documents and Settings\username\Application Data\NUTInstallLog.htm for more information.  

The NAE Update Tool requires IIS to communicate to supervisory engines. Add this optional Windows software component by selecting **Control Panel > Programs > Programs and Features > Turn Windows features on and off**. Then select the Internet Information Services (IIS) components.
<table>
<thead>
<tr>
<th>Error or User Message</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostTransferNote - Tried to check operational status but no response received from host &lt;host name&gt; due to: Unable to connect to the remote server.</td>
<td>Communication between the computer and the NAE has timed out. Lengthen the communication timeouts by displaying the <strong>Communications Options</strong> in the <strong>Timeouts</strong> tab of the <strong>Options</strong> menu (see <a href="#">Set Communication Options menu selection</a>). Try these values: PXE Timeout Discovery = 12, PXE Timeout Download = 15, PXE Max Retries = 10, HTTP Timeout Download = 100. Restart the update process.</td>
</tr>
<tr>
<td>PostfileTransferError - All retries are exhausted but &lt;NAE’s MAC address&gt; is not online.</td>
<td>Release 4.1 and later requires an NAE with 512 MB of flash memory, and the unit you are trying to update has 256 MB of storage.</td>
</tr>
<tr>
<td>512MB of Flash Storage is required for this release. Please contact your JCI representative for upgrade options.</td>
<td></td>
</tr>
<tr>
<td>A Microsoft Windows program indicates that a firewall may be active on your computer. If a firewall exists, disable it, then restart the NAE Update Tool. If you determine that the program has incorrectly stated the presence of a firewall, ignore this message and continue using the NAE Update Tool.</td>
<td>Turn off the firewall on your computer and restart the NAE Update Tool. If you have no firewall enabled, simply ignore this message and begin using the NAE Update Tool.</td>
</tr>
<tr>
<td>Communication to device has failed.</td>
<td>The disk image file stopped downloading because the connection between the NAE and your computer was severed. Check the connection.</td>
</tr>
<tr>
<td>Error creating TFTP server: Address in use: Cannot Bind</td>
<td>Check that the Server IP address in the NAE Update Tool log matches the IP address of your computer. Restart your computer. If the addresses still do not match, on the <strong>Options</strong> menu of the NAE Update Tool, select <strong>Set Defaults</strong>. Delete the Server IP address, and make sure that <strong>Automatically create IP route for clients</strong> is selected. Click <strong>OK</strong>. Save the target file, and then close and restart the NAE Update Tool.</td>
</tr>
<tr>
<td>Error: Maximum Retries Exceeded Error: Communication lost unexpectedly with client (???)</td>
<td>If these errors occur repeatedly, try a <strong>PXE Only</strong> update with your computer connected to the same switch as the NAE.</td>
</tr>
</tbody>
</table>
## Table 13: List of Possible Error and User Messages

<table>
<thead>
<tr>
<th>Error or User Message</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExceptionError - ISAPIListener start failure: Only one usage of each socket address (protocol/network address/port) is normally permitted</td>
<td>The system for which the NAE Update Tool is installed may be running a DHCP or Trivial File Transfer Protocol (TFTP) server. The NAE Update Tool uses these ports. Make the ports available for exclusive use by the NAE Update Tool. Follow the vendor instructions to disable these services or install the NAE Update Tool on a system that does not use a DHCP or TFTP server.</td>
</tr>
<tr>
<td>ExceptionError - TFTPListener start failure: Only one usage of each socket address (protocol/network address/port) is normally permitted</td>
<td></td>
</tr>
<tr>
<td>ExceptionError - PXEListener start failure: Only one usage of each socket address (protocol/network address/port) is normally permitted</td>
<td></td>
</tr>
<tr>
<td>FileTransferError - File transfer error for <code>&lt;file&gt;</code>: File doesn't exist</td>
<td>The disk image that you specified for this NAE in the <strong>Add New Update Target</strong> screen (Figure 26) does not exist on the computer. Check the name of the file.</td>
</tr>
<tr>
<td>File transfer error for <code>&lt;filename&gt;</code>: Maximum retries exceeded. (Is the MTU size too small?)</td>
<td>The file cannot be transferred because the MTU size is not set correctly for the NAE update to complete. For details on how to test the MTU size, see <strong>Test MTU tab</strong>. For details on how to set the MTU size, see Step 2 in <strong>Preparing the computer and NAE</strong>.</td>
</tr>
<tr>
<td>Host name for device <code>&lt;Intended NAE Name&gt;</code> is not correct: <code>&lt;Actual NAE Name&gt;</code></td>
<td>At the end of the update, the NAE Update Tool could not verify that the updated NAE has the correct name. Try the update again. <strong>Intended NAE Name</strong> is the NAE name as configured in the tool. <strong>Actual NAE Name</strong> is the NAE name as read from the engine.</td>
</tr>
<tr>
<td>Internet Information Services (IIS) is not running. You must correct this problem before trying to update a device.</td>
<td>IIS is required to update devices with the NAE Update Tool. Go to <strong>Control Panel</strong> &gt; <strong>Administrative Tools</strong> &gt; <strong>Services</strong>. Locate the World Wide Web Publishing service and verify its Startup Type is set to Automatic. Also, locate the IIS Admin service and verify that it is started. If it is not started, open a command prompt and run the iisreset command. The IIS service stops, and then restarts. If the problem persists, uninstall, and then reinstall Internet Information Services. Restart the NAE Update Tool.</td>
</tr>
<tr>
<td>Maximum retries exceeded</td>
<td>If you have the MCI Access Manager Client installed on your computer, see Step 2 in <strong>Preparing the computer and NAE</strong> for steps on how to set the MTU to 1500.</td>
</tr>
<tr>
<td>No updates have been started since no enabled devices are selected.</td>
<td>You need to set the Status field to Enabled before updating the NAE.</td>
</tr>
</tbody>
</table>
### Table 13: List of Possible Error and User Messages

<table>
<thead>
<tr>
<th>Error or User Message</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Socket error: ICMP Port Unreachable</td>
<td>This error message is due to a routing error in the network when the NAE Update Tool cannot connect to the target engine by using the same port it used originally. In most cases, the network layer corrects this routing problem automatically and the tool tries to reestablish the connection. You can safely ignore this message.</td>
</tr>
</tbody>
</table>
| The Internet Information Services (IIS) Default Web Site is not running properly. You must correct this problem before trying to update a device. | • The Default Web Site might be stopped. Go to Control Panel > Administrative Tools > Internet Information Services. Expand the tree in the left pane to expose the Default Web Site. Right-click Default Web Site and verify that Start is dimmed to indicate the website is running. If it is not dimmed, select Start. Restart the NAE Update Tool.  
• The NAE Update Tool web site might not be configured. Go to Control Panel > Administrative Tools > Internet Information Services. Expand the tree in the left pane to expose the Default Web Site item. Verify that an entry called NAEUpdateTool exists in the tree. If not, reinstall the NAE Update Tool software. |
| This device cannot be updated via the PXE protocol because the current Maximum Transmission Unit (MTU) setting is too small. You must either change the MTU setting of this computer to 1500 or change the Update Process for this device to HTTP Only. | To change the MTU setting, see MTU setting of 1500. Whenever you change this setting, a computer reboot is required. You can also select the HTTP Only update process for this engine. See Adding NAE update targets. |
| Tried to check operational status but no response received from host <169.254.0.0> due to: The operation has timed out. | If this timeout error occurs repeatedly during an update, increase the HTTP Timeout Download value and start the update again. See Timeouts tab. |
| Update failed for <MAC Address>! The device’s release should be <new_release> but is actually <old_release> | At the end of the update, the NAE Update Tool could not verify that the updated NAE is at the intended release level. Try the update again.  
Example for <MAC Address>: 00-10-8D-00-71-D4  
Example for <new_release>: 5.1.0  
Example for <old_release>: 4.1.0 |
<table>
<thead>
<tr>
<th>Error or User Message</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserDefinedError - The update is cancelled since all communication failed. - tried</td>
<td>The NAE Update Tool cannot reach the NAE. The engine might be offline or an incorrect NAE Host Name might be specified. Try reaching the engine using</td>
</tr>
<tr>
<td>Host Name (NAE45) but received this error: Communication timed out. Can the specified</td>
<td>the Ping command from the computer running the NAE Update Tool.</td>
</tr>
<tr>
<td>host name (NAE45) be resolved? Is the device offline? (Is the Host Name spelled</td>
<td></td>
</tr>
<tr>
<td>correctly?)</td>
<td></td>
</tr>
<tr>
<td>You have specified an improper range of target IP addresses. The Base IP address</td>
<td>You have set an incorrect base IP address space size. Enter an IP address that is within range. To generate a valid IP address, click **Automatically</td>
</tr>
<tr>
<td>plus the IP address space size wraps past the subnet specified by the IP address</td>
<td>Create IP Space.</td>
</tr>
<tr>
<td>address mask value.</td>
<td></td>
</tr>
<tr>
<td>Error or User Message</td>
<td>Condition/Solution</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>A compatible gateway has not been detected, indicating that the PC is not on a network. To update an NxE55xx-3 off network, the PC's IP address must be set to 192.168.1.1.</td>
<td>You reimaged a NxE55xx-3 using the PXE update process of the NAE Update Tool instead of using SCT. This message only occurs when the NAE Update Tool is in stand-alone mode while disconnected from the building network. Only NxE55xx-3 models are affected by this potential fault. The message does not appear with SCT 10.0 or earlier; in this case, the NxE55xx-3 update simply fails. Use only SCT 11.0 or later to reimage the NxE55-3, either on or off the building network. If you must update a non-responsive (bricked) NxE55-3 engine using the PXE update process off the building network, follow these steps:</td>
</tr>
<tr>
<td>1. Connect the NxE55-3 and commissioning laptop to an isolated network switch (off-network).</td>
<td></td>
</tr>
<tr>
<td>2. Disable all network adapters on the laptop, but keep the adapter labeled <strong>Local Area Connection</strong> enabled.</td>
<td></td>
</tr>
<tr>
<td>3. Configure this address for the network adapter assigned to Local Area Connection:</td>
<td></td>
</tr>
<tr>
<td>- IP address: 192.168.1.1</td>
<td></td>
</tr>
<tr>
<td>- Subnet mask: 255.255.255.0</td>
<td></td>
</tr>
<tr>
<td>- Default gateway: &lt;none&gt;</td>
<td></td>
</tr>
<tr>
<td>4. Start the NAE Update Tool. By default, the tool selects the network adapter with the 192.168.1.1 address. Also, click <strong>Options&gt;Advanced Mode</strong> to help you monitor the engine update.</td>
<td></td>
</tr>
<tr>
<td>5. Add or select the NxE55-3 as a target engine for the reimage process. If necessary, enter the MAC address and complete all other required fields. Set the <strong>Status</strong> field to <strong>Enabled</strong>. Click <strong>OK</strong>.</td>
<td></td>
</tr>
<tr>
<td>6. Restart the NxE55xx-3 engine to initiate the reimage process.</td>
<td></td>
</tr>
<tr>
<td>7. After the NxE55xx-3 update completes successfully, exit the NAE Update Tool.</td>
<td></td>
</tr>
<tr>
<td>8. Return the commissioning laptop to its original network configuration and re-enable the network adapters you disabled in Step 2 above.</td>
<td></td>
</tr>
<tr>
<td>9. Complete NxE55xx-3 engine commissioning, including the download of its database with SCT.</td>
<td></td>
</tr>
</tbody>
</table>
Table 13: List of Possible Error and User Messages

<table>
<thead>
<tr>
<th>Error or User Message</th>
<th>Condition/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information - There is not enough available flash in this device (&lt;NAE name&gt;) for a quick update to be performed.</td>
<td>The tool determined that the device does not have enough flash memory to qualify for a <strong>Quick</strong> update. An <strong>Extended</strong> update is required. The tool selects <strong>Extended</strong> update for you.</td>
</tr>
<tr>
<td>Information - Quick mode may be selected for this device (&lt;NAE name&gt;).</td>
<td>The tool determined that the device has enough flash memory to qualify for a <strong>Quick</strong> update.</td>
</tr>
<tr>
<td>The available flash could not be read from the device, so Extended mode has been set. If this is not acceptable, you may select Quick and try the Test Login again, or continue with Extended mode.</td>
<td>The tool cannot read the available flash memory from the device, so the <strong>Quick</strong> update will not be used. The tool selects <strong>Extended</strong> update for you.</td>
</tr>
<tr>
<td>Tried to check operational status but no response received from host &lt;IP Address&gt; due to: The request failed with HTTP status 504: Gateway Timeout</td>
<td>The computer you are using to update an NAE might be using a Windows proxy address that is not supported. Either add an explicit list of local address ranges to the Windows proxy configuration, or switch to a proxy specifying a configuration script. For assistance, contact the local IT staff.</td>
</tr>
</tbody>
</table>

Related documentation

The following table contains literature related to the NAE Update Tool and the upgrade process.

Table 14: NAE Update Tool Related Documentation

<table>
<thead>
<tr>
<th>For Information On</th>
<th>See Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Upgrade Process</td>
<td><em>Metasys Server Installation and Upgrade Instructions (LIT-12012162)</em></td>
</tr>
<tr>
<td>Network and IT Considerations</td>
<td><em>Network and IT Guidance for the BAS Professional Technical Bulletin (LIT-12011279)</em></td>
</tr>
<tr>
<td>NAE Configuration and NAE Date and Time Management</td>
<td><em>NAE Commissioning Guide (LIT-1201519)</em></td>
</tr>
<tr>
<td>NIX9 Configuration</td>
<td><em>NIX9 Commissioning Guide (LIT-12011922)</em></td>
</tr>
<tr>
<td>NCE25 Configuration and Field Equipment Controller (FEC) Upgrades</td>
<td><em>NCE Technical Bulletin (LIT-12011267)</em></td>
</tr>
<tr>
<td>NCM45x0-2 Migration and the NCM Update Utility</td>
<td><em>NCM45x0-2 Network Control Module Commissioning Guide (LIT-12011176)</em></td>
</tr>
<tr>
<td>Serial Printer Destination Delivery Agent (DDA)</td>
<td><em>NAE Commissioning Guide (LIT-1201519)</em></td>
</tr>
<tr>
<td>ToggleTunnel or ChangeModel</td>
<td><em>ToggleTunnel and ChangeModel Technical Bulletin (LIT-12011531)</em></td>
</tr>
</tbody>
</table>
Appendix

Stand-Alone NAE update

Use the information in this section if you cannot update an NAE over the facility’s network, which can effect and N50-1 if a PXE server is in use. In this situation, you need to disconnect the NAE from the building network and connect the device to a stand-alone Ethernet switch to update the image.

Hardware requirements

The following hardware is required for connecting to all supported NxEs:

- Two RJ45 Ethernet patch cables
  
  Note: Do not use a crossover cable.

- One FS10x 10/100 Netgear® switch (for example, FS105NA Netgear 5 Port 10/100) or one W-Linx 5-port 10/100 Mini Hub (USB) E63746 or one Netgear 5 Port 10/100 Desktop switch (model FS605) connected to your computer.

  Note:
  
  - NxE55xx-2 engines can connect at 10/100/1,000 Mbps. Connecting to a NxE55xx-2 engine at 1,000 Mbps (1 Gbps), requires a GS108 Netgear 10/100/1,000 switch. This switch can also be used with all of the other supported NxEs.
  
  - Do not use any other switch, hub, or dual-speed hub.

Important: If you use a USB powered Ethernet switch, it must be powered from the computer for the NAE to update. If your Ethernet switch is powered by the NAE, you can experience update problems.

Make sure that the Ethernet cables are patch (straight through) cables. To verify that you have a patch cable, use a cable tester. If you do not have a cable tester, visually inspect the cables by holding both ends of the cable either tab up or tab down. The order of the terminating colors at both ends of a patch cable should be identical. See Figure 42 and Table 15 for an example of an Ethernet patch cable.
Note: The colors of your cable do not need to match the colors in Figure 42 and Table 15. The important characteristic of a patch cable is that the color pairs do not change position between the ends of the cable.

Table 15: Detail for Patch Cable Wiring

<table>
<thead>
<tr>
<th>RJ45 Pin Number</th>
<th>Colors</th>
<th>Wiring Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>White/Orange</td>
<td><img src="image1" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>2</td>
<td>Orange</td>
<td><img src="image2" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>3</td>
<td>White/Green</td>
<td><img src="image3" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>4</td>
<td>Blue</td>
<td><img src="image4" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>5</td>
<td>White/Blue</td>
<td><img src="image5" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>6</td>
<td>Green</td>
<td><img src="image6" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>7</td>
<td>White/Brown</td>
<td><img src="image7" alt="Wiring Diagram" /></td>
</tr>
<tr>
<td>8</td>
<td>Brown</td>
<td><img src="image8" alt="Wiring Diagram" /></td>
</tr>
</tbody>
</table>
Connecting the NAE to the ethernet switch

About this task:
To connect the NAE to the Ethernet switch:

1. Make sure that the NAE is receiving power and running (the RUN LED is on steady).
2. Disconnect the NAE from the Ethernet network.
3. Connect an Ethernet switch with two Ethernet patch cables between the Ethernet port of the NAE and your computer. Make sure that the LAN is not connected to the Ethernet switch. Figure 43 shows an example of an NAE55 connected to a laptop.

![Figure 43: NAE55 to Laptop Connection through Ethernet Switch and Ethernet Patch Cables](image)

4. Verify that the 10/LINK or 100/1000LINK LED on the NAE and Ethernet switch are lit to confirm connectivity between the computer and the NAE through the Ethernet switch.

   **Note:** NxE55xx-2 and NIEx9xx-2 engines can connect at 10, 100, or 1,000 Mbps. Connecting at 1,000 Mbps requires a 1,000 Mbps capable Ethernet switch. See Hardware requirements for the required switch. The 100/1000 LINK LED flashes green for 100 Mbps connections and yellow for 1,000 Mbps connections.

5. Verify that the Local Area Connection for the Ethernet connection to the NAE is enabled and that all other network connections (including wireless connections) are disabled:
   a. In Control Panel, select Network Connections or Network and Dialup Connections.
   b. Verify that the Local Area Connection for the Ethernet connection to the NAE is enabled. All other connections should be disabled or disconnected. To disable or enable a connection, right-click the connection and choose from the menu.

6. Verify that the computer has a valid IP address:
   a. On the Start menu, select Run.
   b. Type cmd, and click OK.
   c. At the command prompt, type ipconfig and press Enter. If the computer IP address is all 0s, wait several minutes. Enter the ipconfig repeatedly until the address is established.

   **Note:** The IP address acquired is an Automatic Private IP Address (APIPA) of the form 169.254.x.x.

7. Proceed with the update. See Adding NAE update targets.

Determining the MAC address of an NAE

You can find the MAC address information in one of the following ways:

- Find the sticker on the NAE cover that contains the MAC address.
• Access the SMP UI, display the object for the NAE that you are updating, and click the **Network** tab. The MAC address appears in the Ethernet MAC Address field.

• Perform a test login of the NAE with the NAE Update Tool. After a successful login, the MAC address field updates for you. For details, see Testing login before updating NAE. (This method requires that a DNS server is present on the network that resolves computer names).

• Connect a computer to the NAE using an Ethernet patch cable. If you are working with an NAE55/NIE55/NIE59, start the NAE IP Tracker tool. If you are working with an NAE45/35, NIE29/39/49, or NCE25, start the NAE Configuration tool. Shortly after receiving power, the NAE MAC address appears in the tool.

**Note:** If you wish to use the NAE Configuration Tool with NAE55s/NIE55s/NIE59s, you must start it before you start the NAE Update tool for the IP address to be captured.

• Using a null modem cable, connect a computer with a VT100 emulator to the serial port indicated in Table 16. Shortly after connecting power to the NxE (approximately 3 minutes), the NxE MAC address appears on the VT100 computer screen. For details, see Table 16 and refer to the **NAE Commissioning Guide (LIT-1201519)**.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Port to Use</td>
<td>RS232C A</td>
<td></td>
</tr>
<tr>
<td>Bits Per Second</td>
<td>115,200</td>
<td></td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Flow Control</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**Table 16: Settings for VT100 Capture of NxE MAC Address**

Special considerations for updating NAEs at the branch office

This section describes how to use the NAE Update Tool in situations where you need to update NAEs at the branch office for multiple customers. By following these steps, you can save time by updating all of the NAEs at once, even when fixed IP addresses are involved. To illustrate, suppose you have the following three customers:

• Customer A has 3 NAEs addressed as 10.10.87.1, 10.10.87.4, and 10.10.87.10, with a subnet mask of 255.255.0.0.

• Customer B has 3 NAEs addressed as 159.222.10.27, 159.222.10.30, and 159.222.10.41 with a subnet mask of 255.255.252.0.

• Customer C has 2 NAEs addressed as 192.150.13.6 and 192.150.13.9 with a subnet of 255.255.255.0.

Follow these steps to update each of the customers' devices:

1. If the NAE Update Tool is currently running, close it.

2. Attach the NAEs and the NAE Update Tool computer to an Ethernet switch that is not connected to any other network.
3. If the computer has a wireless adapter, disable it temporarily. If the computer has more than one wired network adapter, temporarily disable the extra adapters.

4. Set up the Ethernet adapter so that it can communicate to the multiple customer device addresses. Follow these steps:

   a. Determine addresses that are able to communicate to the devices by matching the first three segments of the customer’s address and selecting an unused value for the fourth segment (do not use 0 or 255). In our example:
      a. Customer A: assigned 10.10.87.11 with subnet mask 255.255.0.0
      Customer B: assigned 159.222.10.40 with subnet mask 255.255.252.0
      Customer C: assigned 192.150.13.10 with subnet mask 255.255.255.0

   b. On the NAE Update Tool computer, select Start > Control Panel > Network Connections. If you have Windows 10, Windows 8, or Windows Server 2012, hold down the Windows key and press R to open the Run box. Type ncpa.cpl in the Open field and press Enter. The Network Connections window appears.

   c. Highlight the local area connection that the NAE Update Tool uses. Right-click and select Properties. The Local Area Connection Properties dialog box appears.
d. Select Internet Protocol Version 4 (TCP/IPv4) and click OK. The Internet Protocol (TCP/IP) Properties dialog box appears.
e. If the computer is currently using a static IP address, write down all of the information in this dialog box (Figure 46). You will need this information in a later step.

f. Click **Use the following IP address** if not already set (Figure 46).

g. Click **Advanced**. The **Advanced TCP/IP Settings** dialog box appears.
Figure 47: Advanced TCP/IP Settings Dialog Box

h. If any IP addresses are currently listed, remove them by highlighting each one and clicking **Remove**. Remove any Gateway addresses as well. The dialog box should now resemble Figure 48.
i. Click Add in the IP addresses section (Figure 48). The TCP/IP Address dialog box appears (Figure 49).

j. Add each compatible address from Step a. You need to specify each address individually. If you added all three IP addresses, the Advanced TCP/IP Settings dialog box should resemble Figure 50.
k. Click the DNS tab and delete any listed DNS server addresses. Click OK. The Local Area Connection Properties dialog box appears.
l. Click **OK** to apply the changes.

m. Verify that the addresses were added properly. Open a Command Prompt on the computer and enter this command: `ipconfig /all`. Verify that the result is similar to that shown below:

```
Ethernet adapter Local Area Connection:

 Connection-specific DNS Suffix : 

Description . . . . . . . . . . : Intel(R) 82567LM Gigabit Network Connection

Physical Address. . . . . . . . : 00-26-55-88-2A-78

Dhcp Enabled. . . . . . . . . . : No

IP Address. . . . . . . . . . . : 192.150.13.10
IP Address. . . . . . . . . . . : 159.222.10.40
```

Figure 51: Local Area Connection Properties
5. Add the NAEs to the NAE Update Tool and start the updates as usual.

6. After you have updated the NAEs, start the SCT and download the devices.

7. After you have updated and verified all NAEs, change your Ethernet adapter settings back to what you recorded in Step 4e.

8. Reattach the computer to the corporate network.

Software terms

Use of the software that is in (or constitutes) this product, or access to the cloud, or hosted services applicable to this product, if any, is subject to applicable terms set forth at www.johnsoncontrols.com/techterms. Your use of this product constitutes an agreement to such terms.

Product warranty

This product is covered by a limited warranty, details of which can be found at www.johnsoncontrols.com/buildingswarranty.

Patents

Patents: http://jcipat.com
Index

P
Patch Cable .............................................................. 63
PXE ................................................................. 8

Q
Quick Reference Guide ............................................ 6

R
Regular Mode .......................................................... 28
Related Documentation table .................................. 62
Reset Times Tab ...................................................... 25
Resources ................................................................. 62

S
Select Disk Image Dialog Box ................................ 21
Set Communication Options ................................. 24
Set Defaults Menu Selection .................................. 19
Site Director Default Tab ........................................ 23
Split Screen Adjuster .............................................. 12
Stand-alone Update ................................................ 63
System Requirements ............................................ 11

T
Target List ................................................................ 12
Test Login ................................................................. 43
Test MTU Tab ........................................................... 27
TFTP ................................................................. 8
Timeouts Tab ........................................................... 24
Troubleshooting ...................................................... 50

U
Update Decision Process for Network Engines ..... 8
Update NAE Targets ............................................... 45
Update Process

HTTP Only ............................................................ 17
PXE Only ........................................................ 17
PXE or HTTP .................................................. 17
Update Process Messages .............................. 12, 13
Update Process Overview ......................... 6
Update Timeline

NAE35 ............................................................ 30
NAE45 ............................................................ 30
NAE55 ............................................................ 31
NCE25 ............................................................ 30
NIE55 ............................................................. 31
Update Types

Extended ............................................................ 18
Quick .............................................................. 18

Updating an NAE or Migrating an NAE45-2 to an NCM45-2 .......... 39
Update Prerequisites ............................................. 9
User Interface .......................................................... 12

Upgrade Prerequisites ............................................. 9

User Interface .......................................................... 12

Y
Index